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Abstract

These Application Notes describe a sample configuration using Session Initiation Protocol
(SIP) trunking between the Verizon Business IP Contact Center VolP Inbound SIP Trunk
Service and an Avaya IP Office solution. In the sample configuration, the Avaya IP Office
solution consists of Avaya Session Border Controller for Enterprise Release 6.2, an Avaya IP
Office 500 V2 Release 9.0 Preferred Edition, Avaya Voicemail Pro, Avaya IP Office
Softphone, and Avaya SIP, H.323, digital, and analog endpoints.

These Application Notes complement previously published Application Notes by illustrating
the configuration screens and Avaya testing of IP Office Release 9.0.

IP Office Release 9.0 with Avaya Session Border Controller for Enterprise Release 6.2
has not been independently certified by Verizon labs. These Application Notes can be
used to facilitate customer engagements via the Verizon field trial process, pending
Verizon labs independent certification.

The Verizon Business IP Contact Center VolP Inbound offer referenced within these
Application Notes enables a business to receive inbound toll free calls via standards-based SIP
trunks, without the need for additional TDM enterprise gateways or TDM cards and the
associated maintenance costs.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted in the Avaya Solution &
Interoperability Test Lab, utilizing a Verizon Business Private IP (PIP) circuit connection to
the production Verizon Business IP Trunking service.
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1. Introduction

These Application Notes describe a sample configuration using Session Initiation Protocol (SIP)
trunking between the Verizon Business IP Contact Center VVolIP Inbound Service and an Avaya
IP Office solution. In the sample configuration, the Avaya IP Office solution consists of an
Avaya Session Border Controller for Enterprise Release 6.2, and Avaya IP Office 500 V2
Release 9 Preferred Edition, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya
H.323, SIP, digital, and analog endpoints.

These Application Notes complement previously published Application Notes by illustrating the
configuration screens and Avaya testing of IP Office Release 9.0.

IP Office Release 9.0 with Avaya Session Border Controller for Enterprise Release 6.2 has
not been independently certified by Verizon labs. These Application Notes can be used to
facilitate customer engagements via the Verizon field trial process, pending Verizon labs
independent certification.

Customers using Avaya IP Office with the Verizon Business IPCC service are able to receive
inbound toll-free calls from the PSTN via the SIP protocol. The converged network solution is an
alternative to traditional PSTN trunks such as ISDN-PRI.

In the sample configuration, an Avaya Session Border Controller for Enterprise (SBCE) is used
as an edge device between the Avaya IP Office and Verizon business. The Avaya SBCE
performs SIP header manipulation and provides topology hiding, as well as a variety of other
functions providing security and the presentation of a standardized SIP interface.

Verizon Business IPCC service can be delivered to the customer premise via either a Private IP
(PIP) or Internet Dedicated Access (IDA) IP network terminations. Although the configuration
documented in these Application Notes used Verizon’s IPCC service terminated via a PIP
network connection, the solution validated in this document applies also to IP Contact Center
services delivered via IDA service terminations.

For more information on the Verizon Business IPCC service, visit
http://www.verizonbusiness.com/Products/communications/contact-center/.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to the Verizon Business
IPCC service, as depicted in Figure 1. The Avaya SBCE and IP Office were configured to use
the commercially available SIP Trunking solution provided by the Verizon Business IPCC
service. This allowed Avaya IP Office to receive inbound toll-free calls from the PSTN via the
SIP protocol.

DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 20f70
SPOC 3/7/2014 ©2014 Avaya Inc. All Rights Reserved. VZBIPCC-IPO9SBC


http://www.verizonbusiness.com/Products/communications/contact-center/

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

The testing included executing the test cases detailed in Reference [VZ-Test-Plan], which
contains the Verizon IPCC Interoperability Lab Test Plan. To summarize, the testing included
the following successful SIP trunk interoperability compliance testing:

SIP OPTIONS monitoring of the health of the SIP trunk was verified. Verizon Business,
Avaya SBCE, and IP Office can all monitor health using SIP OPTIONS.

Proper recovery from induced failure conditions such as IP Office reboots, and IP
network outages between Verizon and IP Office, of short and long durations.

Incoming calls from the PSTN were routed to the toll-free numbers assigned by Verizon
Business to the Avaya IP Office location. These incoming calls arrived via the SIP Line
configured in Section 5.4 and were answered by Avaya H.323 telephones, Avaya SIP
telephones, Avaya digital telephones, analog telephones, Avaya Flare® Experience, one-
X® Mobile, Avaya IP Office Softphone, and Avaya IP Office Voicemail Pro.

Proper disconnect when either party hangs up an active call.

Proper disconnect when the PSTN caller abandons (i.e., hangs up) a toll-free call before
the IP Office party has answered.

Proper SIP 486 response and busy tone heard by the caller when a PSTN user calls a toll-
free number directed to a busy IP Office user, an IP Office user with Do-not-disturb
active, or an IP Office user that is logged out (i.e., assuming no redirection is configured
for these conditions). Similarly, busy tone is heard when a PSTN user calls a toll-free
number whose “SIP URI Max Calls per Channel” has been reached (see Section 5.4.4).
Similarly, busy tone is heard when a PSTN user calls a toll-free number directed to a hunt
group whose queue is “full” (i.e. if no redirection is configured for hunt group busy
conditions, see Section 5.5.3).

Proper termination of an inbound IP Toll Free call left in a ringing state for a relatively
long duration.

The display of caller ID on display-equipped Avaya IP Office telephones was verified.
The IP Office capability to use the caller ID received from Verizon to look up and display
a name from a configurable directory was also exercised successfully.

Privacy requests for inbound toll-free calls from the PSTN were verified. That is, when
privacy is requested by a PSTN caller (e.g., dialing *67 from a mobile phone), the
inbound toll-free call can be successfully completed to an IP Office telephone user while
presenting a “WITHHELD” or anonymous display to an IP Office user (i.e., rather than
the caller’s telephone number).

Inbound toll-free long holding time call stability.
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IP Office sends SIP 180 RINGING (no SDP in 180) for inbound calls and ring back tone
is heard by the caller.

Telephony features such as hold and resume, transfer of toll-free calls to other IP Office
users, and conference of toll-free calls.

Incoming voice calls using the G.729(a) and G.711 ULAW codecs, and proper protocol
procedures related to media.

DTMF transmission using RFC 2833. Successful IP Office Voicemail Pro menu
navigation for incoming toll-free calls. Successful use of IP Office Mobile Call Control,
where DTMF sequences can be performed remotely using the SIP Line.

Incoming toll-free calls directed to the Hunt Groups configured in Section 5.5.3 were
verified. Incoming calls could be queued, queued with priority, and be answered by
members of the hunt group as members become available.

Proper DiffServ markings for Avaya SBCE SIP signaling and RTP media.

2.2. Test Results

Interoperability testing of the sample configuration was completed with successful results. The
following observations were noted.

1.

2.

The Verizon IPCC Service does not support fax.

When a call is put on hold by an IP Office user, there is no indication sent to Verizon via
SIP messaging. This is transparent to the users on the call.

Although the Verizon Business IPCC service supports transfer using the SIP REFER
method and IP Office supports sending REFER, IP Office will not send REFER to
Verizon in the verified configuration. When configured, IP Office sends REFER with
Replaces, and Verizon IPCC requires REFER without Replaces.

Although Verizon IPCC, the focus of these Application Notes, is used for inbound toll-
free numbers, inbound toll-free calls can be twinned, forwarded, or transferred back to
the PSTN via the Verizon IP Trunk SIP Line, See Reference [VZBIPT-IPO9SBC]. If an
inbound Verizon IPCC call to an IP Office user is forwarded to a PSTN number using a
separate SIP service through the same Avaya SBC, IP Office may be configured to send a
REFER to Verizon IPCC service when the call is answered. Verizon IPCC service will
respond with a 202 Accepted message followed by 603 Server Internal Error in the
NOTIFY message. This causes the call to drop. To prevent IP Office from sending a
REFER to Verizon IPCC service in this scenario a signaling rule was created in the
Avaya SBCE, as shown in Section 6.7.
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2.3. Support

2.3.1. Avaya

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

2.3.2. Verizon

For technical support on Verizon Business IP Trunk service offer, visit the online support site at
http://www.verizonbusiness.com/us/customer/.
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3. Reference Configuration

Figure 1 illustrates an example Avaya IP Office solution connected to the Verizon Business IP
Contact Center SIP Trunk service. The Avaya equipment is located on a private IP subnet. An
enterprise edge router provides access to the Verizon Business network via a Verizon Business
T1 circuit. This circuit is provisioned for the Verizon Business Private IP (PIP) service.

In the sample configuration, the Avaya SBCE receives traffic from the Verizon Business IP
Contact Center service on port 5060 and sends traffic to port 5072, using UDP for network
transport, as required by the Verizon Business IP Contact Center service. Verizon provided five
toll-free numbers associated with the IP Contact Center service. These toll-free numbers were
mapped to IP Office destinations via Incoming Call Routes as summarized in Table 1. The
Avaya IP Office environment domain known to Verizon was adevc.avaya.globalipcom.com.

PSTN Phone

Fax

Verizon
Business

172.30.205.55 : 5072

)
sIP™ -

IP Office Location

Avaya 1140E
X235
DID: 732-945-0235

map Verizon toll-free numbers to IP Office
Extensions, Hunt Groups, or Functions such as
Voice Mail, Aut i f i

BBE-850-2380
866-851-0107
B66-851-2649
866-852-3221
B66-850-6850

IP Office Incoming Call Routes

Meet-me C
Mobile Call Control
l-| | i
Example INVITE from Verizon:
Request-URI:

-avaya.

A com: 5060

sip:

y I
FROM: sip:+19088485704(@199.173.94.16:5060;user=phone

Contact: sip:+19088485704@172.30.205.55:5072; transport=udp
PAI: sip:+19088485704(3199.173.94.80;user=phone

TO: sip:18668523221@1.1.1.2

Avaya Session Border Controller for

Enterprise

Avaya 1616

Enterprise Router
Mgmt LAN eth5: .
10.80.150.189 - utside Interface
eth1: 1.1.1.2
[] Inside Interface
o ] eth3: 10.64.19.199
- )
| IP Office 500v2 * |
Release 9.0
LAN1: 10.80.150.70 & SIP
Flare® / 5
N IP Office
Ava;za;ﬂﬂ Eﬁmﬂiﬂ Manager  Application
s Server
DID: 732-045-0233  DID: 732-945-0237  Softphone P' =i Voicemail Pro
& oneXE Portal
\/-ji_ e

adevc.avaya.globalipcom.com

Avaya 9508 Digital Avaya T7315E Digital
X232 X231

DID: 732-845-0232 DID: 732-945-0231 Analog phone
or Fax
X241

DID: 732-945-0241

Remote Workers.

e

Flare® Experience One-X& Mobile

Figure 1: Avaya Interoperability Test Lab Configuration

Additionally, the reference configuration included remote worker functionality, introduced with
Avaya IP Office 9.0 with Avaya SBCE. A remote worker is a SIP endpoint that resides in the
untrusted network, registered to IP Office via the Avaya SBCE. Remote workers feature the
same functionality as any other endpoint within the enterprise. This functionality was
successfully tested during the compliance test, using the following endpoints and protocols:
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e Avaya Flare® Experience for Windows (using TLS and SRTP)
e Avaya one-X® Mobile Preferred for IP Office on Android (using TCP and RTP)

The configuration tasks required to support remote workers are beyond the scope of these
Application Notes; hence they are not discussed in this document. For more information on
configuring the Avaya SBCE for IP Office remote workers, consult reference [6].

Table 1 shows an example mapping of toll-free numbers to IP Office users, groups, or functions.
The associated IP Office configuration is shown in Section 5. Since the quantity of toll-free
numbers was limited in the test configuration relative to the desired test coverage, the same toll-
free number was routed to different IP Office destinations (i.e., IP Office configuration changes

were made to the Incoming Call Route destination as needed between successive tests).

Verizon Provided Configured Avaya IP Office Notes
Toll-Free Number Destination(s)
866-851-0107 x235, x239 Avaya 1140E,

Avaya one-X® Mobile

866-850-2380

X232, X241, x234

Digital Telephone with
Mobile Twinning and Mobile
Call Control permission. Also
used to test analog telephone
and Avaya Flare Experience

capabilities.

866-851-2649

X233, x237

Avaya 1616 Telephone,
Avaya 9611 Telephone

866-850-6850

Voicemail Collect on
Voicemail Pro

Allow external callers to
access voice mail toll-free

866-850-6850

Inbound Mobile Call Control

Allow toll-free calls from pre-
configured twinning numbers
to access mobile call control

866-850-6850

Conference Bridge on
Voicemail Pro

Allow external callers to
access conference bridge toll-
free

866-852-3221
(any caller)

“401 Sales” Hunt Group
(with default priority)

Hunt Group with queuing

866-852-3221
(specific callers)

“400 Overdue Account”
Hunt Group

Show IP Office destination
selection based on caller ID

866-852-3221
(specific priority callers)

“401 Sales” Hunt Group
(with High Priority)

Show IP Office priority
queuing based on caller ID

Table 1: Example Verizon Toll Free Number to IP Office Destination Mappings
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4. Equipment and Software Validated
Table 2 shows the equipment and software used in the sample configuration

Equipment Software
Avaya $e53|0n Border Controller for Release 6.2.1 (Q07)
Enterprise
Avaya IP Office 500 V2 Release 9.0.0.829

Avaya Application Server running Voicemail
Pro and one-X® Portal for IP Office

Release 9.0.0-829

Avaya IP Office Manager

Release 9.0.0.0 Build 829

Avaya 1616SW IP Telephone (H.323)

Release 1.33

Avaya 9611SW IP Telephone (H.323)

Release 6.2209

Avaya 1140E IP Telephone (SIP)

Release 04.03.18

Avaya 9508 Digital Telephone Release 0.45
Avaya T7316E Digital Telephone N/A
Avaya IP Office Softphone Release 3.2.3.49

Avaya Flare® Experience for Windows

Release 1.1.4.23

Avaya one-X® Mobile Preferred for IP Office
on Android

Release 1.8.0.9031

Table 2: Equipment and Software Tested
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5. Avaya IP Office Configuration

IP Office is configured via the IP Office Manager program. For more information on IP Office
Manager, consult reference [2]. From the IP Office Manager PC, select Start - Programs >
IP Office = Manager to launch the Manager application. Provided that the IP Office system is
accessible to IP Office Manager, the following will be displayed in the center of the opening

screen:

=
Configuration Service User Login

IP Office Werizon - IP 500 Y2

Service User Mame Administrator

Service User Password

[ Zancel ][ Help ]

Log in with the appropriate configuration credentials. The appearance of the IP Office Manager
can be customized using the View menu. In the screens presented in this section, the View menu
was configured to show the Navigation pane on the left side, the Group pane in the center, and

the Details pane on the right side.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid SIP Trunk Channels license with sufficient Instances
(trunk channels). If Avaya IP Telephones will be used as is the case in these Application Notes,
verify the Avaya IP endpoints license.

File Edit Yiew Tools Help
i Werizan = License -3 3 J
I X[ v]<]|
R BOOTF (6) License Type License | Remate Server
i Opérator (3) (L0 s LIy (S U= -
=) Verizon PLDSHost ID 111309066506
a) System (1)
19 Line (&) Feature License Key Instances Status
“= Control Unit (3) WMPro TTS (Scansoft) _ZMKx¥glvil a@7gKbig_LULX3YNNAFZa 1 yald
A Extension (22) Freferred Edition (Yoicemail Pro) yGW6_YyMadIRbd1SywraSa4@LCLkdkoH 255 yalid
: User (24} Cffice Worker 0s5R27bo5kg1vpb@FOBP v IZAm2dsER 5 Valid
éﬂ Group (4} Receptionist pSyhoOm2yDSTDv IdawfLI2 JuRNHsdon 1 Walid
@ shart Code (73) Mobile Warker *N@IFSVRYDSZ@EqaSTEYENhMEIUhAGMN 5 Walid
@ Service (1) Phone Manager Pro IP Audio Enabled... O@cMoadzxIhSspeBilif_@yw3WoOuPdot 1 Walid
o4, RAS (1 Power User 1MWEWbhjXSFs0l4HE4BdHVENy 35T AVIO s Walid
IPSec Tunneling IvDQUROHSSULF 163290k ze JzdwizH 255 walid
@ Inceming Call Route SIP Trunk Channels HEHY R AR AVHOTREF 0Tk 13K 3 _Lunadrs, 5 walid
€2 wanPart (0} Cuskomer Service Supervisor UFCZaTtOVNE43MgSaLakI4QExIrLLISdy 1 walid
a4 Directory (0) Advanced Edition m¥CFEHYItKaF2aU03EmZL Wik 4@egIEC 255 Walid
{.’i“- Time Profile {0) ALDTE Yoicemail g3tngzoHPD 70K SBPwe TERSHy plw v p@E 255 Valid
@ Firewall Profile (2) Teleworker WYCGxPLEADGY TEXCDIK 4Lk Ok IND 5 Walid
Bl IFRoute (7) CT1 Link Pro w1 OBVEEdG_COESKAMeCweSIMLSIECSC 255 Walid
& Account Code (0 Wave User KOn@ZyITgAkwWWbFTiarFISY cdjyEbbK 4 Walid
= e Phone Manager Pro {per seat) 85BMhevkLA41¥M19_awdSGznlSpZA0L0 1 Valid
gl License (22) YMPro Metworked Messaging shDdqpyWMANIAZYEQZMI0T $WPSUEECoW 255 yalid
& Tunnel (0} IPS00 Yoice Networking Channels 1wkzLvEMG@iaZMyMLgnfrvLypo_GMID 4 Yalid
§ 3 User Rights (8} Customet Service Agent Si0Zxdy195ybaEmffaYRMHGEBARTUSPIOT 5 walid
"¢ ARS(3) Avaya IP endpoints G2xe7BANDOa7XnHkzIR01 TpZz9dwpia_N 5 Walid
f& Location (1) Software Upgrade 255 43CTE_9ERSixbSewBtpRErERIUzSmru] 1 Walid
Essential Edition Virtual Essential Edition 1 Walid
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In the sample configuration, looking at the IP Office 500 V2 from left to right, the first module is
a TCM 8 Digital Station Module. This module supports BCM / Norstar T-Series and M-Series
telephones. The second module isa COMBO6210/ATM4 module. This module is used to add a
combination of ports to an IP500 V2 control unit and is not supported by IP500 control units.
The module supports 10 voice compression channels. Codec support is G.711, G729A and G.723
with 64ms echo cancellation. G.722 is supported by IP Office Release 8.0 and higher. The
“Combo” card will support 6 Digital Station ports for digital stations in slots 1-6 (except 3800,
4100, 4400, 7400, M and T-Series), 2 Analog Extension ports in slots 7-8, and 4 Analog Trunk
ports in slots 9-12. Referring to Figure 1, the Avaya T7315E telephone with extension 231 is
connected to port 1 of the TCM8 module, and the Avaya 9508 telephone with extension 232 is
connected to port 1 of the “Combo” card. The analog extension or fax machine is connected to
the “Combo” card on port 7.

The following screen shows the modules in the IP Office used in the sample configuration. To
access such a screen, select Control Unit in the Navigation pane. The modules appear in the
Group pane. In the screen below, IP 500 V2 is selected in the Group pane, revealing additional
information about the IP 500 V2 in the Details pane.

Fle Edt Wew Tools Help
Werizon = Caonkrol Unit * 1IPS00WZ 'J
AEEAslv 2%
Lnit

R BOOTP (8) Dev Mo, | Dev Type
4w Operator (3) 1P 500 42

Version

Divice Number 1

= Verizon b H] TCHE 9.0.0.529
= System (1) k] COMBOGZ10/ATM4  9.0.0.629 Unit Type 1P 500 Y2
4 Line (8}
<= Control Unit {3) Wersian 9.0.0.529
Ay Extension (22)
I serizd) Serial Mumber 00007058233
Wk Group (4
ik Growp (4) Uit TP dddress 10,50,150.70

B Short Cade (73)
@ Service (1) Interconnect Mumber 1}
ol RAS (1)
e Incaming Call Route Module Mumber Contral Unit
@ WanPort {0)

@ Directory (0)

!(.“ Tirne Prafile {0)
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5.2. System Settings

This section illustrates the configuration of system settings. Select System in the Navigation
pane to configure these settings. The subsection order corresponds to a left to right navigation of
the tabs in the Details pane for System settings.

5.2.1. LAN Settings

The 1P500/IP500 V2 control units have 2 RJ45 Ethernet ports, physically marked as LAN and
WAN. Within the system configuration, the physical LAN port is LAN1, the physical WAN port
is LAN2.

In the sample configuration, LANL1 is used to connect the IP Office to the enterprise network. To
view or configure the IP Address of LAN1, select the LANL1 tab followed by the LAN Settings
tab. As shown in Figure 1, the IP Address of the IP Office is 10.80.150.70. DHCP Mode is set
to “Server” so that IP phones will get an IP Address from the IP Office Server. Other parameters
on this screen may be set according to customer requirements.

= Verizon ) | X[ w <]
System | LANL |LaM2 | DNS || Woicemnail | Telephony | Directory Services | System Events | SMTP | SMOR | Twinning | ¥CM | CCR | Codecs
LaM Settings | yoIp | MWetwork Topology | DHCP Pools
IP Address 10 an 150 70
IP Mask 255 255 255 0
Primary Trans, IP Address 0 a 0 a
RIP Mode Maone v
[] Enable MAT
Mumber OF DHCP TP Addresses (i)
DHCP Made
) server () Client () Dialin () Disabled
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Select the Vol P tab as shown in the following screen. The H323 Gatekeeper Enable box is
checked to allow the use of Avaya IP Telephones using the H.323 protocol, such as the Avaya
1616 and 9611 used in the sample configuration. The SIP Registrar Enable box is checked to
allow Avaya 1140E, Avaya IP Office Softphone, and Avaya Flare® Experience usage. The SIP

Trunks Enable box must be checked to enable the configuration of SIP trunks to Verizon
Business.

If desired, the RTP Port Number Range can be customized to a specific range of receive ports
for the RTP media paths from Avaya SBCE to IP Office. The defaults are used here.

o
o

Verizon & | % | v |

Systern | LAML | LaMz | DMS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR. | Twinning | ¥CM || CCR || Codecs
LAM Settings | ¥oIP | Metwork Topology | DHCP Pools

H323 Gatekeeper Enable
[] Auto-create Extn Auto-create User [] H323 Remote Extn Enable

SIP Trunks Enable

SIP Registrar Enable

[1 auto-create Extn/User [] 1P Remoke Extn Enable
Domain Mame avayalab.com
LDP UDP Pork  |S060 b Remote LDF Port
Layer 4 Prokocol TCP TCP Port  |S060 k- Remoke TCP Port
LS TLS Pork (5061 = Remote TLS Port
Challenge Expiry Time (secs) 1 E
RTFP
Paort Mumber Range
Mirirniirn 49152 % Mairnurn Sizde 3
Pk Mumber Range (MAT)
Mirirriurn 49152 % Mairnurn Sizde 3

Enable RTCP Monitoring on Port 5005
Keepalives

Scope Disabled v

Scrolling down, IP Office can be configured to mark the Differentiated Services Code Point
(DSCP) in the IP Header with specific values to support Quality of Service policies. In the
sample configuration shown below, IP Office will mark SIP signaling with a value associated
with “Assured Forwarding” using DSCP decimal 28 (SIG DSCP parameter). IP Office will mark
the RTP media with a value associated with “Expedited Forwarding” using DSCP decimal 46
(DSCP parameter). This screen enables flexibility in IP Office DiffServ markings (RFC 2474) to
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allow alignment with network routing policies, which are outside the scope of these Application
Notes. Other parameters on this screen may be set according to customer requirements.

DiffSery Settings

rs ~ FS

BS 3| DSCRiHex) [BS % | wideoDSCP(Hex) [FC 5| DSCPMask(Hex) (70 3| 5IG DSCP (Hex)

L

46 7| DICP 46 3| video D5CP 63 D3P Mask, 28 | SIGDSCP

Select the Network Topology tab as shown in the following screen. In the sample configuration,
the default settings are used and the Use Network Topology Info in the SIP Line is set to
“None” in Section 5.4.3. The Binding Refresh Time (seconds) can be used to lower the SIP
OPTIONS timing from the default of 300 seconds. During the testing, the Binding Refresh Time
was varied (e.g., 90 seconds, 120 seconds) to test SIP OPTIONS timing.

B v I

Systern | LAND |LaN2 | DMS || Yaicemall | Telephomy || Direckary Services | Swstem Events | SMTP | SMOR || Twinning | WCM | CCR || Codecs
LAM Settings | woIP | Metwork Topalogy | DHCP Paoals
Metwork Topalogy Discovery

STUN Server Address 0.0.0.0 STUM Part 3478 E
FirewalinaT Type Unknown w
Einding Refresh Time (seconds) 20 &
Public IP Address a ] ] ] Cancel
Public Part
LDP o 3
TP 0 v
LS o £

|:| Fun STUN on starkup
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5.2.2. System Telephony Configuration

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as
shown in the following screen. The settings presented here simply illustrate the sample
configuration and are not intended to be prescriptive. In the sample configuration, the Inhibit
Off-Switch Forward/Transfer box is unchecked so that call forwarding and call transfer to
PSTN destinations via the Verizon Business IP Trunk service can be tested. That is, a call can
arrive to IP Office via the Verizon Business IP Trunk, and be forwarded or transferred back to
the PSTN with the outbound leg of the call using the Verizon IP Trunk service. The
Companding Law parameters are set to “U-Law” as is typical in North American locales. Other
parameters on this screen may be set according to customer requirements.

System | LAML | Loz | DMS | voicemail | Telephony || Directary Services | System Events | SMTP | SMDR | Twinming | vaM | ccR | Codecs

Telephony | Park & Page | Tones & Music | Ring Tones | 5M Call Log || TUI

Analogue Extensions Companding Law
Switch Line:
Default Outside Call Sequence Marmal W
Default Inside Call Sequence Ring Type 1 v © U-Law @ U-Law Line
Default Ring Back Sequence Ring Tvpe 2 W
(:} A-Law C' O-Law Line

Restrict Analogue Extension Ringer Yoltage F

[] ps5 status

Dial Delay Time (secs) 4 E-

Dial Deday Count 0 % Auto Hold

Default Mo Answer Time (secs) 15 3 Dial By Mame

Hold Timeout (secs) 0 - Show Account Code

Park Timeout (secs) w0 4 |:| Inhibit OFF-Swikch Forwardi TransFer
Ring Delay (secs) c = [ Restrict Metwork Inkerconnect

Drop External Only Imprompty Conference
Call Priority Promotion Time (secs) Disabled [ ora E HIL

4

Wisually Differentiate External Call

Defaulk Currency usm W
[] unsupervised Analog Trunk Disconnect Handling

Defaulk Mame Priority Fawor Trunk W
High Quality Conferencing

rMedia Connection Preservation Disabled w
[ =trict s1P5
Digitalfdnalogue Auko Create User
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5.2.3. System Codecs Configuration

To view or change system codec settings, select the Codecs tab. On the left, observe the list of
Available Codecs. In the example screen below, which is not intended to be prescriptive, the
box next to each codec is checked, making all the codecs available in other screens where codec
configuration may be performed (such as the SIP Line in Section 0). The Default Codec
Selection area enables the codec preference order to be configured on a system-wide basis, using
the up, down, left, and right arrows. By default, all IP (SIP and H.323) lines and extensions will
assume the system default codec selection, unless configured otherwise for the specific line or
extension. The RFC2833 Default Payload parameter is new in IP Office Release 9.0. Set the
payload parameter to “101”, the value preferred by Verizon Business.

8 _ ven  EEEIEIREN

System || L&N1 | LANZ | DNS woicemail | Telephony | Directory Services | Swskem Events | SMTP | SMOR | Twinning | WM CCR Codecs

RFC2833 Default Payvload 101 =
Available Codecs Default Codec Selection
Jrsed Selected
G711 ULAN 64k = 2,722 64K
@711 ALAW B4 G711 LILAW &

G711 ALAW 64K
53.7259(a) 8k C5-ACELP
< G.723.1 6K3 MP-MLO

3,722 64K
3.729(5) 5K C5-ACELP
5.723.1 6K3 MP-MLQ

s

5.3. IP Route

In the sample configuration, the IP Office LANL port is physically connected to the local area
network switch at the IP Office customer site. The default gateway for this network is
10.80.150.1. The Avaya SBCE resides on a different subnet and requires an IP Route to allow
SIP traffic between the two devices. To add an IP Route in IP Office, right-click IP Route from
the Navigation pane, and select New. To view or edit an existing route, select IP Route from the
Navigation pane, and select the appropriate route from the Group pane. The following screen
shows the Details pane with the relevant route using Destination LAN1.

= 10.64.0.0 - X vl<]>

IP Route

IP Address 10 64 ] ]

IP Mask. 255 255 0 ]

Gateway IP Address 10 g0 150 1

Destination LAaM1L b

Metric 0 g

[ Proxy arP
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5.4. SIP Line

This section shows the configuration screens for the SIP Line in IP Office Release 9. The
recommended method for configuring a SIP Line is to use the template associated with these
Application Notes. The template is an .xml file that can be used by IP Office Manager to create a
SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.5.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New = SIP Line. Then, follow the steps outlined in Sections 5.4.2 —5.4.5.
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5.4.1. SIP Line From Template
1. Copy the template file to the computer where IP Office Manager is installed. Rename the

template file to US_VerizonIPCC-ASBCE_SIPTrunk.xml. The file name is important
in locating the proper template file in Step 5.

Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

£ 1P Office Manager, Preferences

Preferences || Directories | Discovery | Yisual Preferences | Security || validation

Iron Size | Small w
Multiline Tabs
Enable Template Options

o [ o [ com |[ = |

Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

" Avaya IP Office R9 Manager Verizon [9.0.0.829] [Administrator(Adm

File  Edit  View | Tools | Help
i werizon Extension Renumber...,
i 9 z - | | a Line Renumber. ..
Conneck Ta...
IP Offices
Export 3
R soote {8 SCN Service User Management decs
{7 Operator (3) ——
- - stemn ;| LAN1 | LA
(=57 Werizon Busy on Held Yalidation
2 Syskem (1) e
7 Line (71 MSM Configur ation
“2r Conkrol Unik
<& Extension (3 ; Contack Infarmatio
a User (24) | Import Templates in Manager |
5% Group (4) 1 [[] ]5et contact infFarm

In the pop-up window (not shown) that appears, select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure. Click OK (not shown) to
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continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New = New SIP Trunk From Template.

IP Offices
R BoOTP (8] Lu_ne Humber | Lin | [ et |F\na||:|gue o
i Operator (3) 15 And

[=)-%=p Werizan n“ = . > | |—|
“ap Systel A i H323Line
™ ﬂ Generate Analogue Trunk Template IP DECT Line
“Zy Conkro L L
A& Extens j—.] Copy Settings From Template ine

E SM Line
B User@@ o oy Chrl4
u erov - SIP DECT Line
@ short 53| Copy ChrkC
B servicd Mew SIP Trunk From Templake
4= =
o RAa (1 75 Delete Chrl+Del S—
@ Incarmin I:l
Ej? WanPo +  Validate
@ Direcky I:I
f-“ Tirme: P
@ Firema e From Template (Binary) I:I
E LP Rou Show In Groups 701
Crour

S License Customize Columns. .. |In Service
g Tunnel’s = ==

5. In the subsequent Template Type Selection pop-up window, select “United States” from
the Country pull-down menu and select “VerizonlPCC-ASBCE” from the Service
Provider pull-down menu as shown below. These values correspond to parts of the file
name (US_VerizonlIPCC-ASBCE_SIPTrunk.xml) created in Step 1. Click Create new

SIP Trunk to finish creating the trunk.
B

[

Locale
Country | United States w |
Service Provider |"-.-"eri2u:un|F'|:|:-.-'1'-.SEH:E LY | [] Dizplay Al

[ Create new SIP Trunk, ] [ Cancel ]

Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.2 —5.4.5.
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5.4.2. SIP Line = SIP Line Tab

The SIP Line tab in the Details pane is shown below for Line Number 18, used for Avaya SBCE
to the Verizon Business IPCC service. The ITSP Domain Name is configured with the inside IP
address of the Avaya SBCE as shown in Figure 1. By default, the In Service and Check OOS
boxes are checked. In the sample configuration, IP Office will use the SIP OPTIONS method to
periodically check the SIP Line. The time between SIP OPTIONS sent by IP Office will use the
Binding Refresh Time for LANL, as shown in Section 5.2.1.

The Call Routing Method can retain the default “Request URI” setting, or may be changed to
“To Header”, to match Incoming Call Routes based on the contents of the “To Header”. In the
sample configuration, the default “Request URI” setting was used. As can be observed in the
sample INVITE header contents in Figure 1 and Section 8.1.2, the Request-URI and the To
header do not necessarily contain the same number. In the tested configuration, the Request-URI
contained the toll-free number, and the “To” header contained 1 followed by the toll-free
number.

In the sample configuration, the IP Office Country Code is set to 1. The “From” and “PAI”
headers received from Verizon for calls from U.S. PSTN numbers contain “+1” before the
calling PSTN number. By configuring the IP Office Country Code to 1, the caller ID display
presented to IP Office users will be the PSTN number without any codes or prefixes. For
example, a call from 3035387006 would display 3035387006. If the Country Code does not
match the value following the “+” from Verizon, the IP Office user display would show the
contents of the International Prefix field, followed by the value following the “+”, followed by
the PSTN number. For example, if the Country Code parameter were left blank, the IP Office
user would see a display such as “01113035387006”. Aside from display implications, if the
Country Code is not configured, other patterns may also fail to match as expected, such as a
match on the Incoming CLI field of the Incoming Call Route. See Section 5.7.3 for
configuration of incoming call routing based on the calling number.

SIP Line |Transport|SIP URI| YaIP | T3& Fax| SIP Credentials
Line Mumber 1g 3
ITSP Damain Narme 10.64,19.199 In Service
URI Type SIP R
Prefix Check 0035
MNational Prefix Call Routing Method Request LRI 4
Country Code 1 FC;rriE\E?dtgLI I;Tﬂn;btai:lﬁirng calls
International Prefix 011 Marme Pricrity Favor Directory W
Send Caller 1D Mone “ Caller ID From From header [
Association Method Brv Source IP address w Send From In Clear F
User-Agent and Server
Headers
Service Busy Response 486 - Busy Here R
Action on CAC Location Limit | Allow Yoicemail A
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Towards the bottom of the screen, REFER Support is unchecked as the REFER method
provided by IP Office is not supported by Verizon IPCC. The Method for Session Refresh
parameter and the related Session Timer (seconds) parameter are new with IP Office Release
9.0. The Method for Session Refresh is set to “Reinvite” and the Session Timer (seconds) is
set to “1800”. With this configuration, IP Office will send re-INVITES every 15 minutes (half of
the set value) to keep the active session alive. The Media Connection Preservation parameter
retains the default setting “Disabled”. Click OK (not shown).

[] REFER Support

Method for Session Refresh Reinvite w
Session Timet (seconds) 1a00 E
Media Connection Preservation | Disablzd A4

5.4.3. SIP Line - Transport Tab

Select the Transport tab. The ITSP Proxy Address is set to the inside IP address of the Avaya
SBCE as shown in Figure 1. In the Network Configuration area, “TCP” is selected as the
Layer 4 Protocol. The Send Port and Listen Port can retain the default value 5060. The Use
Network Topology Info parameter is set to “None”.

E SIP Line - Line 18 ek - X|vl<]=

SIP Ling| Transport |SIP URI|WoIP | T38 Fax|SIP Credentials

ITSP Proxy Address | 10.64.19.193

Mebwork Configuration

Laver 4 Protacol TCP R Send Port (5060 -
Lse Mebwark Topology Info - [Mone - Listen Pork (5060 £
Explicit DMS Server(s) 0 o 0 1] 0 1] 0 I

Zalls Rouke wia Regiskrar

Separate Registrar
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5.4.4. SIP Line - SIP URI Tab

Select the SIP URI tab. To add a new SIP URI, click the Add... button. In the bottom of the
screen, a New Channel area will be opened. To edit an existing entry, click an entry in the list at
the top, and click the Edit... button. In the bottom of the screen, the Edit Channel area will be
opened.

In the sample configuration, each of the Verizon-provided toll free numbers are entered as a SIP
URI, with the specific number entered in the Local URI, Contact, and Display Name fields.
The PAI parameter is left at the default value of “None”. The Registration parameter is set to
the default “0: <None>" since Verizon Business [PCC service does not require registration. The
Incoming Group parameter, set here to 18, will be referenced when configuring Incoming Call
Routes to map inbound SIP trunk calls to IP Office destinations in Section 5.7. The Outgoing
Group parameter, set here to 0, is not relevant in that Verizon Business IPCC service is inbound
only. Click OK.

B SIP Line - Line 18 e -\ X[vi<l>
SIP Line| Transport| SIP URD \vaIP || T38 Fax|SIP Credentials

Channel | Groups Via Local URI  Contact  Display Mame = PAI add...

1 15 0 <., B06850.., 8665... 86685023580 N

z 18 0 <... ©66850.., &§665... G668506550 ] Remave

3 18 0 <... B6E6851... 8668... 8668510107 M...

4 15 0 <., B06851.., 8665... 86068512649 N Edit...

5 15 0 <. BO6852,., 8668... 86068523221 M

Edit “hannel

Wia =Mane =

Local URI Ge65502380 w

Contact SE65502380 w

Display Mame 8668502380 w

Pal Mone w

Reqgistration 0: <Mone> W

Incoming Group 18

(Qukgaing Group o

Max Calls per Channel 10 "

IP Office allows the number of simultaneous calls to a specific SIP URI to be managed using the
Max Calls per Channel field. In the following screen, note that the Max Calls per Channel
field has been changed from the default 10 to 2. With this configuration, two simultaneous calls
to the number 866-850-6850 will be allowed. Once two calls are active, and a third call is
attempted to 866-850-6850, IP Office will return a SIP 4xx response. Calls to other toll-free
numbers using this same SIP Line are unaffected by the Max Calls per Channel for a different
URI. Therefore, this approach could be used to control the maximum number of calls to each of
the specific toll-free numbers, preventing a surge of calls to a given toll-free number from
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monopolizing the available call handling capacity of the access line or IP Office resources. An
alternative means to restrict the number of simultaneous calls to a toll-free number that
terminates on a hunt group would be to limit the queue size of the destination hunt group. If a
non-priority call arrives to IP Office to a hunt group with a fixed size queue, and the queue is
full, and there is no voice mail for the hunt group, IP Office returns a 486 Busy Here. See
Section 5.5.4 for hunt group configuration.

Edit Channel
Wia

Local URI
Cankack

Display Mame
PaI
Reqgistration
Incorming Group
Cukgoing Group

Mazx Calls per Channel

<None |
668506550
668506850
6658506850
Mane

0 <Mone=
158

1]

2

4

W
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5.45. SIP Line - VoIP Tab

Select the Vol P tab. In the sample configuration, the Codec Selection was configured using the
“Custom” option, allowing an explicit ordered list of codecs to be specified, different from the
system default (see Section 5.2.3). The arrow buttons can be used such that G.729(a) 8K CS-
ACELP and G.711 ULAW 64K codecs are listed in the Selected column. This configures IP
Office to support either G.729a or G.711MU for this SIP Line. The DTMF Support parameter
can remain set to the default value “RFC2833”. The Re-invite Supported parameter can be
checked to allow for codec re-negotiation in cases where the target of an incoming call or
transfer does not support the codec originally negotiated on the trunk. Verizon preferred the
G.729A codec in SDP, while also allowing the G.711MU codec. The IP Office configuration
shown below matches these Verizon preferences. In the course of testing, the IP Office
configuration was varied such that G.711MU was the preferred or only codec listed, and
G.711MU calls were also successfully verified. The PRACK/100rel Supported parameter
should be left at the default unchecked value. Since the Verizon Business IP Contact Center
service does not support fax, the Fax Transport Support parameter is set to “None”, and the
T38 Fax tab need not be visited. Since the Verizon Business IPCC service does not require
registration, the SIP Credentials tab need not be visited. Click OK (not shown).

ﬁ SIP Line - Line 18 e - X v <>

SIF Ling|| Transpart | SIP URI| ¥0IF T35 Fax| SIP Credentials
|:| waoIP Silence Suppression

[] allow Direct Media Path

Codec Selecti Cush v
odec Selection ustam Re-invite Supported
Unused Selected
G711 ALAW E4K i &.729(a) Gk C5-ACELP [ Codec Lockdawn
G722 B4k, G711 LLAW B4k [] Prack/100rel Supported

2,723, 1 6BK3 MP-MLOQ
Faorce direct media with phones

i 5711 Fax ECAN
=
Fax Transport Suppork Mone w
Location Cloud w
Call Initiakion Tirmeout (s34 E
DTMF Support RFCZZ2833 w
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5.5. Users, Extensions, and Hunt Groups

In this section, examples of IP Office Users, Extensions, and Hunt Groups will be illustrated. In
the interests of brevity, not all users and extensions shown in Figure 1 will be presented, since
the configuration can be easily extrapolated to other users. To add a User, right click on User in
the Navigation pane, and select New. To edit an existing User, select User in the Navigation
pane, and select the appropriate user to be configured in the Group pane.

5.5.1. Digital User 232

The following screen shows the User tab for User 232. As shown in Figure 1, this user
corresponds to the Avaya Digital 9508.

“ Avaya9508: 232 ef-B X v«

Marne Extension

Menu Programming || Mobility | Group Membership | Announcements || SIP Personal Directory

Analo 241
§anayagll40E o Lser ‘oicemail | DD short Codes | Source Numbers | Telephony | Forwarding | Dial In || Yoice Recording || Button Programming
§ svayalete 233 Mare Avayadsns

§ svayassil 237 Passward -
¥
Awaysdezl 238 Confirm Password etk
Avayade30 236
Extnz0z 202 Account Status Enabled v
I Extriz03 203 .
Extriz0é 204 Hiame
Extnz0s 205 Extension 232
Extnz06 206 ’
Y Eytnza7 207 Email Address
Extnz0d 208 Locale &
Extnzi0 210
} Extnzil 211 Priority 5 v
Extnzi2 212
o Syskem Phane Rights Mone w
Extnzi3 213
ExtnZz14 214 Profile Power Lser N
Extnzie 216
§ e [ receptionist
;NDUSEI’
frgremotema, .. Enable Softphane
:HSoftphone 234 Enable one-¥ Portal Services
frT7316E 231

Enable one-1 TeleCommuter
Enable Remote Worker

[] Enable Flare

[ Enable Mabile YalIP Client
] send Maobilicy Email
|:| Ex Directory

Device Type % Avaya 9508

The following screen shows the SIP tab for User 232. In the sample configuration, the SIP
Name and Contact parameters are configured with a Verizon Business IP Trunk DID number
for the user, 7329450232. As shown in [VZBIPT-IPO9SBC], these parameters configure the user
part of the SIP URI in the From header for outgoing SIP trunk calls, and allow matching of the
SIP URI for incoming calls from Verizon IP Trunk service, without having to enter this number
as an explicit SIP URI for the SIP Line. The SIP Display Name (Alias) parameter can optionally
be configured with a descriptive name. If all calls involving this user and a SIP Line should be
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considered private, then the Anonymous box may be checked to withhold the user’s information

from the network.

=] Avaya9508: 232 -9 X[ wvl<]|>

User | Yoicemail | DND | Short Codes | Source Mumbers | Telephory || Forwarding | Dial In || Yoice Recording || Button Programming

Menu Programrming | Maobility | Group Membership | Announcerments | SIP Personal Directory
SIP Mame 7329450232
SIP Display Mame (Alias) |Avayado0d

Conkack 7329450232

|:| Anonymous

5.5.2. Avaya Flare Experience User 234 with IP Office Softphone Privileges

The following screen shows the User tab for User 234. This user corresponds to a user that will
be granted “Power User”, Flare features and Avaya IP Office Softphone features. The Profile
parameter is set to “Power User”. The Enable Softphone and Enable Flare boxes are checked.

Mame

Password

Confirm Passwaord
Account Status

Full Marme

Extension

Email Addrass

Locale

Pricrity

Systern Phone Rights

Profile

Mahility | Group Membership | Announcements | SIP Personal Direckary

User | yoicemail | DD

Saftphane

Hk

Hkkk

Enabled v

234

5 W

Maone w

Power User v
|:| Receptionist

Enable Softphone

Enable one-% Portal Services

Enable one-= TeleCommuter

Enable Remate Warker

Enable Flare

[] Enable Mobile woIP Client
[1 send Mobility Emai
[] Ex Directory

Device Tvpe ah Unknown SIP device

Short Codes | Source Mumbers | Telephony | Forwarding | Dial In | Woice Recording | Butbon Programming | Menu Programming
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Like the user with extension 232, the SIP tab for the user with extension 234 is configured with a
SIP Name and Contact specifying the user’s Verizon Business DID number using the Verizon
Business IP Trunk service, as detailed in [VZBIPT-IPO9SBC].

User | Woicemail | DD Short Codes | Source Numbers | Telephony | Forwarding | Dial In || Yoice Recording | Button Programming | Menu Programming

Mability || Group Membership | Announcements | SIP Personal Directory
SIP Mame 7329450234
SIP Display Mame (Alias) | Softphone

Cantack F329450234

[] Anonymous

The following screen shows the Voicemail tab for the user with extension 234. The Voicemail
On box is checked, and a voicemail password can be configured using the Voicemail Code and
Confirm Voicemail Code parameters. In the verification of these Application Notes, incoming
calls from the Verizon Business IPCC service to this user were redirected to VVoicemail Pro after
no answer. VVoicemail messages were recorded and retrieved successfully. Voice mail navigation
and retrieval were performed locally and from PSTN telephones using the Verizon Business
IPCC toll-free numbers, to test DTMF using RFC 2833, and to test assignment of a Verizon-
provided toll free number to the “Voicemail Collect” feature (e.g., via the *17 short code shown
in Section 5.6).

Mobility | Group Membership | Announcements | SIP Personal Directory

User | “Woicemail | DD Shart Codes | Source Mumbers | Telephony || Forwarding | Dial In || Yoice Recording || Butkon Pragraniming || Menu Programming

Yoicemail Code oktck Yoicemail On
Confirm Voicemall Code  [¥+*+* [ woicemai Help
Waicemnail Ennail [ woicemail Ringhack,

wWoicemail Email Reading

[ ums web Services

Select the Telephony tab. Then select the Supervisor Settings tab as shown below. The Login
Code will be used by the Flare Experience and IP Office Softphone user as the login password.

Mability | Group Membership | Announcements | SIP Personal Direckary
User | voicemail | DMD || Short Codes | Source Mumbers | Telephony | Forwarding | Dial In | Woice Recording | Button Programming | Menu Programming
Call Settings | Supervisor Settings | Mulki-line Options || Call Log || TUI
Login Code Hokkok [ Force Login
Login Idle Period {secs) [ Farce Account Code
Monitor Group <Mone= w
Coverage Group <Mone= ~ [T 1ncoming Call Bar
Skatus on Mo-Answer Logged Cn {Mo change) W ] Qutgoing Call Bar
Tl et ol ciial & AT i
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Select the Call Settings tab as shown below. Check the Call Waiting On box to allow an IP
Office Softphone logged in as this extension to have multiple call appearances (e.g., necessary
for call transfer from IP Office Softphone).

Mobility | Group Membership | Announcements | SIP Personal Direckory

User | Yoicemai | DMD | Short Codes | Source Mumbers | Telephony | Forwarding | Dial In || Woice Recording | Button Programming | Menu Programming
Call Settings | Supervisor Settings | Multi-line Options | Call Log || TUI
Outside Call Sequence Default Ring W Zall Waiting On

Inside Call Sequence Default Ring “ answer Call Waiting ©n Hold

The following screen shows the Extension information for this user, simply to illustrate the VVolP
tab available for a SIP Telephone. To view, select Extension (not shown) from the Navigation
pane, and the appropriate extension from the Group pane. Select VolP in the Details pane. The
new Codec Selection parameter may retain the default setting “System Default” to follow the
system configuration shown in Section 5.2.3Error! Reference source not found.. Alternatively,
“Custom” may be selected to allow the codecs to be configured for this extension, using the
arrow keys to select and order the codecs.

SIP Extension: 8001 234

IF Address 0 o o 0 |:| WoIP Silence Suppression
[] Local Hold Music
Codec Selecti System Default b
Rt ¥Stem Jerau Allow Direct Media Path
B Reinvi
- T o Gl Re-invite Supported
G711 LLAY 64K ] use Offerer's Preferred Codec
G711 ALAW 64k
G, 729%a) &k C3-pCELP D Coder Lockdown
G.723.1 K3 MP-MLO)
== [] reserve Avaya IP endpoint license
Reserve 3rd party IP endpoint license
S
Fax Transpoark Support | Mone w
TOM-=IP Gain Default v
IP-=TDM Gain Default v
DTMF Suppoark RFC2833 w
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5.5.3. Hunt Groups

During the verification of these Application Notes, users could also receive incoming calls as
members of a hunt group. To configure a new hunt group, right-click HuntGroup (not shown)
from the Navigation pane, and select New. To view or edit an existing hunt group, select
HuntGroup from the Navigation pane, and the appropriate hunt group from the Group pane.

The following screen shows the Hunt Group tab for a hunt group with Extension 401 and Name
“Sales”. This hunt group was configured to contain various telephones from Figure 1. The Ring
Mode was set to “LongestWaiting” (i.c., “longest waiting”, most idle user receives next call).
Click the Edit button to change the User List.

Longest Waiting Group Sales: 401 gk-M | X vw|=<|-=

Group | Queuing || Overflow || Fallback || Yoicemail | Yoice Recording | Announcements || SIP

Mare Sales Prafile Standard Hunt Group w
Extension 401 [] Ex Directory
Ring Mode Longestyaiting w Mo Answer Time (secs)  |[Jystem Defaulk (15) -
Huold Music Source Mo Change A
Ring Tore QOverride Mone w
Agent's Status on No-Answer
Applies To Mane 4
Iser Lisk
Extension Marne
235 Avayal 140E
232 Avwayadsng
237 Avayadell
231 T7316E
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The following screen shows the Queuing tab for hunt group 401. In the sample configuration,
the hunt group was configured to allow queuing so that incoming Verizon toll-free calls could be
queued when all the members of the hunt group were busy on calls. In the testing associated with
these Application Notes, the Queue Length was varied using both “No Limit” and specifically
sized queues. For example, if the Queue Length is configured to 2, and if two calls are already
in queue, a third call to the Verizon toll-free number corresponding to this hunt group will get
busy tone because IP Office will send a 486 Busy Here (i.e., if there is no Voicemail for the hunt
group). As another example, if the Queue Length has a fixed limit of 2, and if two calls are
already in queue, a third call to the Verizon toll-free number destined for this hunt group from a
priority caller (see Section 5.7.3) will be queued ahead of non-priority callers, temporarily
expanding the queue.

E Longest Waiting Group Sales: 401

Hunk Group | QUeding | Overflow | Fallback | Yoicemail | Voice Recording | &nnouncernents || SIP
QueLing On
Queue Length Io Lirnit = Mormalize Queue Length
Ciueue Tvpe Assign Call On Agent Answer w
Calls In Queue Alarmm

Zalls In Queue Threshold

Analog Extension ko Makify <Mone = w

The following screen shows the Announcements tab for hunt group 401. In the sample
configuration, when a call arrives when all members of the hunt group are busy on calls, the
caller will first hear ring back tone. If a member of the hunt group does not become available
after 10 seconds, the call will be answered by IP Office (i.e., 200 OK will be sent to Verizon),
and the toll-free caller will hear a first announcement. Note that the Flag call as answered box is
relevant for reporting applications, but does not change the fact that IP Office will answer the
call when the first announcement is played. If the call is still not answered after the first
announcement completes, the caller will hear music, a repeating second announcement, music,
and so on until the call is answered by a member of the hunt group, or answered by voicemail for
the hunt group (if configured). If a member of the hunt group becomes available while the caller
is listening to ring back, music, or an announcement, the call is de-queued and delivered to the
available member.
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IP Office supports priority for queuing. For example, if low priority calls are waiting in queue, a
higher priority call entering queue can be moved to the front of the queue and serviced before
lower priority callers. For an inbound SIP trunk call, the priority can be specified on the
Incoming Call Route as shown in Section 5.7.3.

Announcements On

W ait before 1st announcement (seconds)

Flag call as answered

Post announcement tone

Znd Announcement

Wait before Znd announcement (seconds)

Repeat lask announcerment

W' gt before repeat {seconds)

10

Longest Waiting Group Sales: 401

Hunt Group | Queuding | Cwerflow | Fallback, | Yoicemail | Woice Recording "’- 5 sIP

& [ synchronize Calls

e ]

Plav 1st announcement

TMusic on hold w

20

Plav Znd announcement

!

!
|

4

A —

e [E] 4

4¥
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5.6. Short Codes

In this section, various examples of IP Office short codes will be illustrated. To add a short code,
right click on Short Code (not shown) in the Navigation pane, and select New. To edit an
existing short code, click Short Code in the Navigation pane, and the short code to be
configured in the Group pane.

The following screen illustrates a short code that acts like a feature access code rather than a
means to access a SIP Line. In this case, the Code “*17” is defined for Feature “Voicemail
Collect”. This short code will be used as one means to allow a Verizon toll-free number to be
programmed to route directly to voice messaging, via inclusion of this short code as the
destination of an Incoming Call Route. See Section 5.7 for configuration of Incoming Call
Routes.

B

= *17: Voicemail Collect B - X w|<]|>=
Short Code

Code *17

Feature Yaicemail Collect “

Telephone Mumber  |7U
Line Group ID 0 W

Locale w

Force Account Code [
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The following screen illustrates another short code. In this case, the Code “555N;” is defined for
Feature “Conference Meet Me” and Telephone Number “N”. In the verification of these
Application Notes, this short code was used in conjunction with a VVoicemail Pro module named
“MeetMeConf”. Although the Voicemail Pro configuration is beyond the scope of these
Application Notes, the module enabled a PSTN caller to dial a Verizon toll-free number, be
prompted to enter a conference ID and PIN by Voicemail Pro, and then be transferred to the
appropriate meet-me conference based on the ID entered by the caller. Local IP Office callers
could also dial 555xxx to join the corresponding conference with 1D Xxx.

556N;: Conference Meet Me k- X w <>

Short Code

Code 555M;

Feature Conference Meek Me b
Telephone Mumber |

Line Group 10 ] w

Locale “

Force Account Code [

5.7. Incoming Call Routes

In this section, IP Office Incoming Call Routes are illustrated. Each Incoming Call Route will
map a Verizon Business toll-free number to a destination user, group, or function on IP Office.

In some cases, the destination will be chosen based on the combination of the toll-free number
and the caller id of the caller. Example mappings are summarized in Table 1 in Section 0. To
add an incoming call route, right click on Incoming Call Route (not shown) in the Navigation
pane, and select New. To edit an existing incoming call route, select Incoming Call Route in the
Navigation pane, and the appropriate incoming call route to be configured in the Group pane.
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5.7.1. Incoming Call Route to a Specific Telephone Extension

In the screen shown below, the incoming call route for Incoming Number “8668502380” is
illustrated. The Line Group Id is “18”, matching the Incoming Group field configured in the
SIP URI tab for the SIP Line to the Verizon Business IPCC service, in Section 5.4.4.

B 18 8668502380 gf -8 X[ vl<]>

Standard | yoice Recording | Destinations

Bearer Capability Ay oice -
Line Group ID 18 R
Incoming Mumber BAAE502350

Incoming Sub Address

Incaming CLI

Locale v
Priority 1-Low e
Tag

Haold Music Source Systemn Source w
Ring Tone Override Mane b

Select the Destinations tab. From the Destination drop-down, select an extension to receive the
call when a PSTN user dials 8668502380. As shown in Table 1, 8668502380 is the number
associated with IP Office user extension 232. (The Destination was changed in the course of
testing to associate different destinations with the toll-free numbers.)

18 8668502380 et - [ X w <]

Standard | Yoice Recording | Destinations

TimeProfile Destination Fallback Extension

F Default Value 232 Avayads0s v “

Incoming Call Routes for other direct mappings of toll-free numbers to IP Office users are not
presented here, but are configured in the same fashion.
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5.7.2. Incoming Call Routes to a Hunt Group by Dialed Toll-Free Number

In the screen shown below, an incoming call route for Incoming Number “8668523221” is
illustrated. The Line Group Id is “18”, matching the Incoming Group field configured in the
SIP URI tab for the SIP Line to Verizon Business in Section 5.4.4.

= 18 B668523221 - X wl<]|>

Standard | voice Recording || Destinations

Bearer Capability Ary Moice A
Line Group 10 18 v
Incoming Murmber 8668523221

Incoming Sub Address

Incoming CLI

Locale i
Priotity 1-Low w
Tag

Hold Music Source Syskem Source W
Ring Tone Cwverride Mone v

Select the Destinations tab. From the Destination drop-down, select the destination to receive
the call when an arbitrary PSTN user dials 8668523221. As shown in Table 1, 8668510107 is
the toll-free number associated with IP Office hunt group extension 401, the “Sales” hunt group.

18 8668523221 etk -2 X wvl=<]>

Standard | Yoice Recording | Destinations

TimeProfile Destination Fallback Extension

» Diefault Yalue 401 Sales w A

5.7.3. Incoming Call Routes Based on Calling Party Number

This section presents a simple example showing that IP Office can use the calling party number
to distinguish call priority or call destination, for calls to the same toll-free number. Although the
matching shown here is based on the full calling number, partial matching is also possible (e.g.,
to match a calling area code for a targeted geographic treatment).

In the screen shown below, the incoming call route for Incoming Number “8668523221” and
Incoming CLI 3035387022 is illustrated. The Line Group Id is “18”, matching the Incoming
Group field configured in the SIP URI tab for the SIP Line to Verizon Business in Section 5.4.
Note that the Incoming Number is the same as the toll-free number configured in the previous
section. This route will be used for calls to the toll-free number specifically from a caller with
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caller ID “3035387022”. In this case, to allow this caller to be treated with priority when calling
in for “Sales”, the Priority field is set to “3 — High”.

= 18 B668523221 ek - [ X | w|<]>

Standard |\-'|:|ice Recording | Destinations

Eearer Capability |.0.n3-' Waice w |
Line Group 10 |13 3 |
Incoming Mumber |8668523221 |

Incoming Sub Address | |

Incaming CLT 3035382215 |
Locale | v
Priatity '3 - High v/
Tag | |
Hold Music Source | System Source v
Ring Tone Override PriorityCall v

Select the Destinations tab. From the Destination drop-down, select the extension to receive the
call when PSTN user 3035387022 dials 8668523221. In this case, the Destination is also the
hunt group “401 Sales”, but since high priority has been configured via the Standard tab,
incoming calls from this caller will move to the front of the queue, and be serviced before calls
waiting in queue from other non-priority callers.

18 8668523221 k-0 [ X wv|<]|=

Standard | Yoice Recording Destinations|

TimeProfile Destination Fallback Extension
[ 2 Diefault Yalue 401 Sales “ v
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5.7.4. Incoming Call Routes to Various IP Office Features

In the sample configuration, the incoming call route for Incoming Number “8668506850” was
varied to test different destination features, such as VVoice Mail, Mobile Call Control, and
Conference Bridge, as shown in Table 1 in Section 0. The screen showing the Standard tab for
this toll-free number is shown below.

18 8668506850 ek - X wvl<]|>
Bearer Capability Any Moice w
Line Group ID 15 w
Incoming Number BeEE506850
Incoming Sub Address
Incoming CLI
Locale A4
Priotity 1-Low w
Tag
Hold Music Source Syskem Source w
Ring Tone QOverride Mone “

When configuring an Incoming Call Route, the Destination field can be manually configured
with a number such as a short code, or certain keywords available from the drop-down list. At
different times during testing, the Destinations tab for 8668506850 was configured to contain
the following destinations:

o “*17” (short code “Voicemail Collect”, as shown in Section 5.6). With this destination,
an incoming call to 8668506850 will be delivered directly to voice mail, allowing the
caller to log-in to voice mail and access messages.

e “VM:MeetMeConf” With this destination, an incoming call to 8668506850 will be
delivered directly to the Voicemail Pro Module “MeetMeConf” created for use as a
conference bridge.

An example screen showing the short code configured for VVoicemail Collect is shown below.

18 B668506850 ef - [ X v =<]|=

Standard | Yaice Recording | Destinations

TimeProfile Destination Fallback Extension
» Default Yalue *17 “ “
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5.8. SIP INVITE Without SDP

The Verizon IPCC “enhanced transfer” service sends an initial INVITE without SDP to the
transfer-to site of an enhanced transfer. To allow the IP Office to be the recipient of this type of
transferred call, a NoUser Source Number can be configured as follows.

From the Navigation pane, select User. From the Group pane, scroll down past the configured
users and select the user named NoUser. From the NoUser Details pane, select the tab Source
Numbers. Press the Add... button to the right of the list of any previously configured Source

Numbers. In the Source Number field shown below, type SIP_ALLOW_EMPTY_INVITE.

Mew Source Mumber

Source Mumber SIP_ALLOW _EMPTY _IMYWITE

The source number SIP_ALLOW_EMPTY _INVITE should now appear in the list of Source
Numbers as shown below.

i —

= NoUser: ek - X wl<]>

Button Programming | Menu Programming | Mobiliey || Group Membership || Announcements | SIP Personal Direckory

User || Yoicemail | DND || Short Codes | Source Mumbers | Telephory | Forwarding | Dial In | Yeice Recording

SIP_USE_PAI_FOR_PRIMACY
SIP_ALLOMY _EMPTY _INVITE Remove

Edit...

With this configuration, IP Office can be the recipient of a Verizon IPCC enhanced transfer
where the initial INVITE will not have SDP information
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5.9. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK if desired.

=

Save Configuration E| |E|Fz|
IP ffice Settings

Verizon

Configuration Rebook Mode
@ Merge

() Immediate

) when Free

3 Timed

Reboot Time

TN

all Barring

Ok H Cancel H Help ]
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6. Configure Avaya Session Border Controller for Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the Avaya SBCE
software has already been installed.

Use a WEB browser to access the Element Management Server (EMS) web interface, and enter
https://ipaddress/sbc in the address field of the web browser, where ipaddress is the management
LAN IP address of the Avaya SBCE.

Log in with the appropriate credentials. Click Log In.

Q V Q o Log In
lsemame: ucsec

Password:  |esesemsmen

SESSIOI‘I BO I'del' COI'ItI'O' Ier This system is restricted solely to suthorized users for legitimate
i business purposes only. The actual or sttempted unauthorized access,
for Enterprlse use or modifications of this system is strictly prohibited. Unauthorized

users are subject to company disciplinary procedures and or criminal
and civil penafties under state, federal or other applicable domestic and
fareign lavs

The use of this system may be monitored and recorded for
administrative and security reasons. Anyone accessing this system
expressly consents to such monitaring and recording, and is advised
that if it revesls possible evidence of criminal activity, the evidence of
such activity may be provided to law enforcement officials

All users must comply with all corporate instructions regarding the
protection of information assets

@2011 - 2013 Avaya Inc. Al vights reserved

The Dashboard for the Avaya SBCE will appear.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings  Help  Log Qut

Session Border Controller for Enterprise AVAYA

Dashboard Dashboard
Administration T Installed Devices
Backup/Resti
ackup/restore System Time 10:55:35 AM MST Refresh | EMS
Systern Management
. Global Parameters “ersion B.2.1.007 Micro SBC
- Glabal Profiles Build Date Mon Dec 8 17:33:.02 CET 2013

> SIP Cluster
> Domain Palicies

Incidents (past 24 hours)

MNone found Micro SBC: No Subscriber Flow Matched
> TLS Management

> Device Specific Seftings Micra SBC: No Subscriber Flow Matched
Micra SBC: No Subscriber Flow Matched
Micro SBC: Mo Subscriber Flow Matched

Micra SEC: No Subscriber Flow Matched

Add

Mo notes found
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To view system information that was configured during installation, navigate to System
Management. A list of installed devices is shown in the right pane. In the case of the sample
configuration, a single device named “Micro SBC” is shown. To view the configuration of this
device, click View as highlighted below.

Alarms  Incidents  Statistics

Logs Diagnostics  Users

Settings  Help  Log Out

Dashboard
Administration
Backup/Restare
System Management
> Global Parameters
> Global Profiles

> SIP Cluster

> Domain Policies

Session Border Controller for Enterprise

System Management

Devices H Updates H SSL VPN H Licensing |

AVAYA

Managerment [P

I SBC
(P LT ipgwgen) 10:80.150.199

6.2.1.007 Commissioned

Reboot  Shutdown ReatanApphcatmmEdil Delete

The System Information screen shows the Network Configuration, DNS Configuration and
Management IP(s) information provided during installation and corresponds to Figure 1. The
highlighted Al and B1 IP addresses are the ones relevant to the configuration of the SIP trunk to
Verizon. Other IP addresses assigned to these interfaces on the screen below are used to support
remote workers and they are not discussed in these Application Notes.

System Information: Micro SBC X

r General Configuration Device Configuration
Appliance Mame Micro SBC HA Mode Mo
Box Type SIP Twao Bypass Mode Mo
Deployment Mode  Proxy
r Network Configuration
Public IP Metmask Interface
10.64.19.199 10.64.19.199 255.255.255.0 10.64.19.1 Al
1.1.1.2 1.1.1.2 2552552550 1.1.1.1 B1
10.64.19.201 10.64.19.201 255.255.255.0 10.64.191 Al
1.1.1.3 1.1.1.3 2552552550 1.1.1.1 B1
1.1.1.4 1.1.1.4 2552552550 1.1.1.1 B1
r DNS Configuration Management IP(s)
Primary DNS 172.30.209.4 ’7 IP 10.80.150.199
Secondary DMS
DMS Location Oz
DMS Client IP 1.1.1.2
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6.1. Network Management

The Network Management screen is where the network interface settings are configured and
enabled. During the installation process of Avaya SBCE, certain network-specific information is
defined such as device IP address(es), public IP address(es), netmask, gateway, etc. to interface
the device to the network. It is this information that populates the various Network Management
tab displays, which can be edited as needed to optimize device performance and network
efficiency. Navigate to Device Specific Settings = Network Management and verify the IP
addresses assigned to the interfaces and that the interfaces are enabled. The following screen
shows the enterprise interface is assigned to Al and the interface towards Verizon is assigned to
B1.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings  Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Network Management: Micro SBC
Administration
Backup/Restare
Systern Management Network Configuration ‘ | Interface Configuration |
» Global Parameters Micro SBC
> Global Profiles
» SIP Cluster
Al MNetmask A2 Netmask l:l B1 Netmask
> Dormain Palicies
» TLS Management add
4 Device Specific Settings ' Address Public IP G Interface
Network [1064.19.199 | | 1084191 | [a1 v Delete
Management
Media Interface 112 | ERE | [B1 v| Delete
Signaling Interface
Signaling Forking [1064.19.201 | | [oB4.19.1 | [a1 v Delete
End Point Flovs 113 | [ EEE | [ ¥ Delste
Session Flows
Relay Services 1114 | ERE | [B1 ¥| Delete
SHMP

The following screen shows interface Al and B1 are Enabled. To enable an interface click the
corresponding Toggle button.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings  Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashhoard Network Management: Micro SBC

Administration
Backup/Restore

Interf. -
Systemn Management Configuration

> Global Parameters Micro SBC 3 Administrative Status
> Global Profiles Al Enabled Toggle
> SIP Cluster a2 Disabled Toggle
> Damain Palicies
B1 Enabled Toggle

> TLS Management
4 Device Specific Settings

Network

Management
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6.2. Routing Profile

Routing profiles define a specific set of packet routing criteria that are used in conjunction with
other types of domain policies to identify a particular call flow and thereby ascertain which
security features will be applied to those packets. Parameters defined by Routing Profiles include
packet transport settings, name server addresses and resolution methods, next hop routing
information, and packet transport types.

Create a Routing Profile for IP Office and Verizon Business IP Contact Center SIP Trunk
service. To add a routing profile, navigate to Global Profiles & Routing and select Add. Enter
a Profile Name and click Next to continue.

Routing Profile

Profile Marme IP Office

The following screen shows Routing Profile “IP Office” created for IP Office. The Next Hop
Server 1 IP address must match the IP address of the IP Office LAN settings entered in Section
5.2.1. Leave the Routing Priority based on Next Hop Server box checked and enter ““TCP” for
the Outgoing Transport field matching the Layer 4 Protocol set in IP Office SIP Line
=>Transport in Section 5.4.3.

View Routing Rule X

Friarity 1
LIRI Group *
Mext Hop Server 1 10.80.150.70

Mext Hop Server 2

Mext Hop Priority
MAPTR ]
SRY O
Mext Hop in Dialog ¥
lghore Route Header ]
Cutgoing Transpoart TCP
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The following screen shows Routing Profile “VVz_IPCC” created for Verizon. The Next Hop
Server 1 is the IP address and port of the Verizon SIP signaling interface. It is only necessary to
include the port after the IP address when it is not the default SIP port. Choose UDP for
Outgoing Transport.

View Routing Rule X

Friority 1
LRI Group *
Mext Hop Senver 1 172.30.205.55:5072

Mext Hop Senver 2

Mext Hop Priorty o
MNAPTR

SRV

Mext Hop in Dialog

lgnore Route Header

Cutgaing Transport LD

6.3. Topology Hiding Profile

The Topology Hiding profile manages how various source, destination and routing information
in SIP and SDP message headers are substituted or changed to maintain the integrity of the
network. It hides the topology of the enterprise network from external networks.

Click the Add button to add a new profile, or select an existing topology hiding profile to edit. In
the sample configuration, the “default” profile was cloned and modified for Verizon.

In the Replace Action column an action of Auto will replace the header field with the IP address
of the Avaya SBCE interface, or the service provider SIP Proxy depending on the header, and the
Overwrite will use the value in the Overwrite Value. In the example shown, “Vz_IPCC_TH”
was cloned from the default profile and will later be applied in the direction of Verizon.
Overwrite is selected for the From header and domain of “adevc.avaya.globalipcom.com” is
inserted. This is the enterprise domain known to Verizon Business IPCC service.
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Alarms  Incidents  Statistics

Logs Diagnostics  Users Settings  Help  Log Gut

Dashhoard
Administration
Backup/Restore
Systern Managerment

Session Border Controller for Enterprise

AVAYA
Topology Hiding Profiles: Vz_IPCC_TH
Add

Tapology Hiding Prafiles

Click here to add a description,

default
> Global Parameters Topology Hiding
4 (lobal Profiles cisco_th_profile
Dormain DoS v IPCC TH Criteria teplace Action Overwrite Value
. - - Record-Route IP/Dormain Auto
Fingerprint
Server Interworking IPO_RW_TH soP IP/Domain Auto
Phone Interworking Wz IPT_TH Referred-By IP/Domain Auta
Media Forking To IP/Dormain Auto
Rautin
¢ Refer-To IP/Domain Auta
Server Configuration
Topology Hiding From IP/Domain Overwrite adevc.avaya.globalipcom.com
Signaling Manipulation ia IP/Dornain Auto
URI Graups Reguest-Line IP/Domain Auto
> SIP Cluster
-Edit
> Dorain Policies -

6.4. Server Interworking Profile

The Server Interworking profile configures and manages various SIP call server-specific
parameters such as TCP and UDP port assignments, heartbeat signaling parameters (for HA
deployments), DoS security statistics, and trusted domains. Interworking Profile features are
configured based on different Trunk Servers. There are default profiles available that may be
used as is, or new profiles can be configured as described below.

In the sample configuration, separate Server Interworking Profiles were created for IP Office and
Verizon Business IPCC service.

6.4.1. Server Interworking Profile — IP Office

In the sample configuration, the IP Office Server Interworking profile was cloned from the
default avaya-ru profile. To clone a Server Interworking Profile for IP Office, navigate to
Global Profiles = Server Interworking, select the avayu-ru profile and click the Clone
button. Enter a Clone Name and click Next to continue.

Clone Profile

Profile Narme avaya-n

IP Office Interwrk

Clone Mame

The following screen shows the “IP Office Interwrk” profile used in the sample configuration,
with T.38 Support set to “Yes”. Default values can be used for all other fields.
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Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings  Help  Log Gut

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: IP Office Interwrk
Administration
i
Backup/Restore -
Systerm Management Interwarking Profiles Click here to add a description
cs2100
> Global Parameters General H Timers H URI Manipulati || Header Mani ; || Ad d
4 Global Profiles avaya-ru =
o in Dos General B
omain Do
) O By Bawar Hold Support NONE
Fingerprint
CISCO-CCm o
Server Interworking 180 Handling More
Fhone Interwarking ClRS 181 Handling None
Media Farking OCS-FrantEnd-Server 182 Handling Naone
Routing IP Office Interwrk 183 Handing None
Server Configuration
- - Refer Handl I
Topology Hiding W-Interwrk efer Handling o
Signaling Manipulation Wz-IPCC-Interwrk Fux Handling Mo
URI Groups Diversion Header Suppaort Mo
» SIP Cluster Delayed SDP Handling Mo
» Domain Policies
T.38 Support Yes
» TLS Management
URI Sch SIP
» Device Specific Settings cneme
“ia Header Format RFC3261
Privacy Enabled Mo
User Name
P-Asserted-ldentity Mo
P-Preferred-ldentity Mo
Privacy Header
DTMWF
DTMF Support Mone v

6.4.2. Server Interworking Profile — Verizon

To create a new Server Interworking Profile for Verizon, navigate to Global Profiles 2 Server
Interworking and click Add as shown below. Enter a Profile Name and click Next.

Interworking Profile

Profile Name Yz-IPCC-Interwrk

The following screens show the “Vz-IPCC-Interwrk” profile used in the sample configuration.
On the General tab, default values can be used for all fields.
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Session Border Controller for Enterprise AVAYA
Dashhoard Interworking Profiles: Vz-1PCC-Interwrk
Administration
Backup/Restore
Systemn Management
> Global Parameters OeEID © i i i
General H Timers || URI Manipul ‘ ‘ Header Manipul ‘ ‘ Advanced ‘
4 (Global Profiles avaya-n ~
Domain DoS
) ) O B Sy Hold Support NONE
Fingerprint
Server Interworking FrEEEEm 180 Handling Hone
Phone Interworking ELRE 181 Handling Nane
Wedia Forking 0OCS-FraniEnd-Server 182 Handling Hong
Routing IP Office Intersrk 183 Handling None
Server Configuration _
Topology Hiding Wz-Interwrk Refer Handling Mo
Signaling Manipulation VzIPCCAnterwrk URI Group Mone
URI Groups test 3xx Handling Mo
> SIP Cluster Diversion Header Support Mo
> Domain Policies Delayed SOF Handling Mo
> TLS Managerment
4 Device Specific Settings ReImite Handling o
Mebwark Management T.38 Support Mo
Media Interface URI Scheme SIP
Signaling Interface Via Header Format RFC3261
Signaling Farking
End Paint Flows
Session Flows Privacy Enabled Mo
Relay Services User Name
SNMP P-Assertad-ldentity Mo
Syslog Management
P-Preferrad-ldentity Mo
Advanced Options
> Troubleshooting Privacy Header
DTMF Support Mone -
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Timers tab:

Dashboard
Administration
Backup/Restore

> Glohal Parameters

4 Glohal Prafiles
Domain DoS
Fingerprint

Media Forking

Systemn Management

Server Interworking
Phone Interwaorking

Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups

> SIP Cluster

Session Border Controller for Enterprise

Interworking Profiles: Vz-IPCC-Interwrk

cs2100

avaya-r
QCS-Edge-Server
cisco-com

cups
OCS-FrontEnd-Server
IP Office Interwrk
Wz-Interwrk
VzIPCC-Interwrk

test

General H Timers || URI Manipulati H Header M

pulati ||Advanced |

AVAYA

Min-SE
Init Timer
tax Timer

Trans Expire

Invite Expire

TCP Caonnection Inactive Timer

SIP Timers

Advanced tab:

Dashboard
Administration
Backup/Restore

4 Glohal Profiles
Darnain DoS
Fingerprint

Media Forking

> Domain Policies
> TLS Management

Systemn Management
> Glohal Parameters

Server Interworking
Phone Interevarking

Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Graups

> SIP Cluster

> Device Specific Settings

Session Border Controller for Enterprise

Interworking Profiles: Vz-Interwrk

cs2100

avaya-ry
0CS-Edge-Server
cisco-ccm

cups
QCSE-FrontEnd-Server
IP Office Interwrk
Vzinterwrk
Wz-IPCC-Interwrk

test

General | | Timers | ‘ URI Manipulati | ‘ Header M. lati ‘ ‘ Advanced
Record Routes Bath
Topology Hiding: Change Call-ID Yes
Call-Info MAT Ma
Change Max Forwards Yes
Include End Paint IP for Context Lookup Mo
QCS Extensions Ma
AVAYA Extensions Ma
NORTEL Extensions Ma
Diversion Manipulation Mo
Metaswitch Extensions Ma
Reset on Talk Spurt MNo
Reset SRTP Context on Session Refresh Mo
Has Remote SBC Tes
Route Response on Via Port Mo
Cisco Extensions Mo
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6.5. Server Configuration

The Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. Together, these tabs configure and manage various SIP call server-specific
parameters such as TCP and UDP port assignments, heartbeat signaling parameters, DoS security
statistics, and trusted domains.

In the sample configuration, separate Server Configurations were created for IP Office and
Verizon Business IPCC service.

6.5.1. Server Configuration — IP Office

To add a Server Configuration Profile for IP Office, navigate to Global Profiles = Server
Configuration and click Add. Enter a descriptive name for the new profile and click Next.

Add Server Configuration Profile

Profile Marme

The following screens illustrate the Server Configuration for the Profile name “IP Office”. In the
General parameters, the Server Type is set to “Call Server”. In the IP Addresses / Supported
FQDNs area, the IP Address of the IP Office LAN 1 interface in the sample configuration is
entered. This IP address is 10.80.150.70. In the Supported Transports area, TCP is selected,
and the TCP Port is set to “5060”.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings  Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IP Office
Adrinistration
Backup/Restare - .
System Management =enver profles ! ‘ | futh | ‘ fieanh | ‘ Ad )
> Global Paramneters IP Office Serer Type Call Server
# Global Profiles VenzeniPT IP Addresses / FQDNs 10.80.160.70
Darain Do
Fingerprint Supported Transports TCP
Senver Interwarking TCP Port 5080
Phone Interworking
Media Forking
Routing
Server Configuration
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Default values can be used on the Authentication and Heartbeat tabs (not shown). On the
Advanced tab, the Interworking Profile is set to “IP Office Interwrk” created in Section 6.4.1
for IP Office. If remote workers will not be used, Enable Grooming can be selected to allow the
same TCP connection to be used for all SIP messages from this device. In the sample
configuration, this server configuration is also used for remote workers and IP Office uses
different TCP connections to each endpoint, therefore “Grooming” is disabled.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings  Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IP Office
Administration
Backup/Restore
Systern Managernent Se B3 General | ‘ Authentication ‘ | Heartheat ‘ | Advanced
IP Office

+ Global Pararneters Enable DoS Prataction O
4 Global Profiles Werizon-IPT

Dornain DoS Enable Grooming ¥

Fingerprint Interwarking Profile IP Office Intenirk |

Server Interworking Signaling Manipulation Script Mone

Phone Interworking
Media Forking

Routing

Server Configuration

TCF Caonnection Type SUBID

DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 50 of 70
SPOC 3/7/2014 ©2014 Avaya Inc. All Rights Reserved. VZBIPCC-IPO9SBC



6.5.2. Server Configuration - Verizon

To add a Server Configuration Profile for Verizon, navigate to Global Profiles = Server
Configuration and click Add. Enter a descriptive name for the new profile and click Next.

Add Server Configuration Profile

Profile Name Verizan-IPCC

The following screens illustrate the Server Configuration for the Profile name “Verizon-IPCC”.
In the General parameters, the Server Type is set to “Trunk Server”. In the IP Addresses /
Supported FQDNSs area, the Verizon-provided IP address is entered. In the sample configuration
this is “172.30.205.55”. In the Supported Transports area, UDP is selected, and the UDP Port
is set to “5072”.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: Verizon-IPCC
Administration
Backup/Restore
Systern Management Server Profiles General | ‘ Authentication ‘ | Heartbeat | | Advanced
IP Office
» Global Parameters Sarver Type Trunk Server
a W -IFT
Global Profiles Br=on IP Addresses / FQDNs 172.30.205.55
Domain DoS :
VerizonIPCC Supported Transporis uopP
Fingerprint
UDP Part a072

Server Interworking

Phone Interworking
Edit

Media Forking
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Default values can be used on the Authentication and Heartbeat tabs (not shown). On the
Advanced tab, Enable Grooming is not used for UDP connections and left unchecked. The
Interworking Profile is set to “Vz-IPCC-Interwrk” created in Section 6.4.2 for Verizon.

Session Border Controller for Enterprise AVAYA
Dashboar Server Configuration: VVerizon-IPCC
Ad trati
Backup/Restare - .
Systern Managerment =enver broflss S L H futt H tacth H Ad
© Global Pararmeters P Office
Enable DoS Protection O
4 Glohal Profiles Werizon-IPT
Enable Grooming [l
Damain Do VerizonIPCC
Fingerprint Interwarking Profile Y- IPCC-Interwik
Server Interworking Signaling Manipulation Script None
Phone Intenworking UDP Connection Type SUBID
Media Forking
Routing

Server Configuration

Topology Hiding

6.6. Media Rule

Media Rules define RTP media packet parameters such as prioritizing encryption techniques and
packet encryption techniques. Together these media-related parameters define a strict profile that
is associated with other SIP-specific policies to determine how media packets matching these
criteria will be handled by the Avaya SBCE security product.

Select Domain Policies = Media Rules from the left-side menu as shown below. In the sample
configuration, a single default media rule “default-low-med” was used with the DSCP values
“EF” for expedited forwarding (default value) for Media QoS as shown below.

Session Border Controller for Enterprise AVAYA

Dashhaard Media Rules: default-low-med

Adrministration
Add |F\Iter By Device.. V|

cormmended to edit the defaults. Try cloning or addin

Backup/Restore

Media Rules

Systern Management

> Global Pararmeters e

Media NAT H Media Encry

> Global Profiles default-low-med-enc
> SIP Cluster default-high

RTCP Enabled O

4 Domain Policies
default-high-enc
Application Rules

Border Rules avaya-low-med-enc
Media Rules Enabled
Security Rules Q03 Type D3GR

Signaling Rules

Audio QoS

Audio DSCP EF

Time of Day Rules

End Point Palicy
Groups

Session Policies

Wideo DSCP EF

> TLS Management
< Device Specific Settings

MNetwark Management
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6.7. Signaling Rule

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

Clone and modify the default signaling rule to block REFER messages from IP Office to Verizon
IPCC and to add the proper quality of service to the SIP signaling. To clone a signaling rule,
navigate to Domain Policies = Signaling Rules. With the default rule chosen, click Clone (hot
shown). Enter a descriptive name for the new rule and click Finish.

Clone Rule

Rule Mame default

Clone Name Wz_IPCC_Sig_rule

Select the Requests tab, and select the Add Out Request Control button (not shown). Select
“REFER” as the Method Name. In the In Dialog Action and Out of Dialog Action, select
“Blocks with...” and type “405” and “Method Not Allowed” as shown below. The intent is to
have the SBC return a “405 Method Not Allowed” response whenever a REFER is sent to
Verizon IPCC from IP Office. See Section 2.2 for additional information.

Edit Request Control

Proprietary Request

Method Mame REFER
Block with... +

| [Method Mot Allowed

Block with .. v

In Dialog Action

Out of Dialog Action

laos | [Method Mot Allowed
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Once complete, the Request Headers tab appears as follows.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: Vz_IPCC_Sig_rule
Adrinisiration 7] [Filter By Dovice. o
Backup/Restore
Systern Management Signaling Rules Glick here to add & description
default
» Global Parameters etaul General ‘ ‘ Requests H Resp H Request Head H Resp Head || Signaling QoS ‘ uciD
> Global Profiles No-Content-Type-Ch...

> SIP Cluster [Add In Request Control ] [Add Qut Reguest Contral

4 Domain Palicies

default_Qos_AF32

In Dialog Action Out of Dis on Proprietary  Direction

Vz_IPCC_Sig_rule
Application Rules Block with "405 Method Not Block with "405 Method ot
OCH Wi ELno 0 DCK il etno 0

Border Rules IPC_RW¢_Sig_Rule 1 REFER - 3

Allowed Allowed Mo Out Edit  Delete

Media Rules
Security Rules
Signaling Rules

The following screen shows the Signaling QoS set with the DSCP value “AF32” for assured
forwarding.

Session Border Controller for Enterprise AVAYA

Dashhoard Signaling Rules: Vz_IPCC_Sig_rule
Administration

Add |F\Iter By Device. .. V\

Signaling Rules

Backup/Restore

System Management

default
> Global Parameters General || Req H Resp H Req Headers H Resp Headers ‘ ‘ Signaling QoS | ucin
> Global Profiles No-Content-Type-Ch
Si ling QoS
> SIP Cluster default_CioS_AF32 ansiing b &
4 Domain Policies QoS T DSCP
Vz_IPCC_Sig_mule 0 1ype
Application Rules Dsce AF
Border Rules IPO_RW._Sig_Rule
Media Rules

Security Rules

Signaling Rules

6.8. Application Rule

Application Rules define which types of SIP-based Unified Communications (UC) applications
the Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In
addition, you can determine the maximum number of concurrent voice and video sessions the
network will process in order to prevent resource exhaustion.

Select Domain Policies = Application Rules from the left-side menu as shown below. In the
sample configuration, a single default application rule “default-trunk” is used and will be
applied to the Endpoint Policy Group in the next section.
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Alarms Settings  Help  Log Out

Incidents S s Logs Diag

Session Border Controller for Enterprise AVAYA

Dashhoard
Administration

Application Rules: default-trunk

Add [ Filter By Device v

Backup/Restore

Application Rules

ommended to edit the daefaults: Try cloning or adding a new ruls instead

default
Application Rule

default-trunk

Systemn Management
» Global Parameters
» Global Profiles

> SIP Cluster

4 Domain Palicies

Out Maximum Concurrent ins  Maximum ns Per Endpoint

2000 2000

Application Type

default-subscriber-low
Voice

L default-subscriber-high
Application Rules Yideo O 0O
Border Rules default-server-low
Media Rules

Security Rules

default-zerver-high

IFO_RW_app_rule
Signaling Rules

CDR Support Maone

Time of Day Rules
End Paoint Palicy

Groups

ession Policie

RTCP Keep-Alive Mo

6.9. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to a Server Flow in Section 6.12.

To create a new policy group, navigate to Domain Policies = Endpoint Policy Groups and
click on Add as shown below. The following screen shows the “SIP-Trunk-Policy” with
defaults selected for all fields, with the exception of Application set to “default-trunk”, and
Signaling, which is set to “default_QoS_AF32” as shown below. The details of the non-default
rules chosen are shown in previous sections.

Alarms  Incidents

Session Border Controller for Enterprise

Dashboard

Adrinistration

Backup/Restare

System Management

> Global Parameters

> Global Profiles

> SIF Cluster

4 Domain Policies
Application Rules

Statistics

Logs  Diagnostics

Users Seftings  Help  Log Out

AVAYA

Policy Groups: SIP-Trunk-Policy

Add

default-low

default-low-enc

default-red

default-med-enc

|F\Iter By Device... -

Click here to add & description.

Haover over & rowe to see its descrigtion.

Policy Group

Time of Day

Order Application

Signaling

Border Rules default-high —
efault-low-

Media Rules defouthighen: defaulttrnk  defaul il default-law defaull_QoS_AFT2  default Edit Clone
Security Rules OCS-defaul-high
Signaling Rules
Time of Day Rules avayadeflow-anc
End Point Policy avaya-def-high-subsc. ..
Groups avaya-def-high-serer
Session Policies

> TLS Management SIP-Trunk-Policy
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Similarly, a separate profile named “Vz-IPCC-Policy” was created for Verizon Business IP
Contact Center SIP Trunk service using defaults selected for all fields, with the exception of
Application set to “default-trunk” and Signaling set to “VVz_IPCC_Sig_rule” as shown below.

Session Border Controller for Enterprise AVAYA

Dashboard
Administration

Policy Groups: Vz-IPCC-Policy

Add ‘Fi\lerEy Device... ~

Backup/Restore

Systern Managerment

> Global Parameters

> Global Profiles

> SIP Cluster

4 Domain Palicies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Time of Day Rules

End Point Policy
Groups

Session Policies
> TLS Management
> Device Specific Settings

default-low
default-low-enc
default-rmed
default-rmed-enc
default-high
default-high-enc
OCE-default-high
avaya-deflov-enc
avaya-defhigh-subsc...
avaya-defhigh-serer
SIP-Trunk-Policy
VzIPCC-Policy

IPO Rernote Worker

Policy Group

Signaling Time of Day

Order Application

default-low-
default-trunk default med

default-low Wz_IPCC_Sig_rule  default Edit  Clane

6.10. Media Interface

The Media Interface screen is where the SIP media ports are defined. Avaya SBCE will accept
SIP media on the defined ports. Create a SIP media interface for the inside and outside IP

interfaces.

To create a new Media Interface, navigate to Device Specific Settings = Media Interface and
click Add. The following screen shows the media interfaces defined for the sample

configuration.

Alarms  Incidents

Statistics

Logs  Diaghostics

Users

Settings  Help

Dashboard

Administration

Backup/Restore

Systern Management

> Global Parameters

> Global Profiles

> SIP Cluster

> Daomain Palicies

> TLS Managerment

4 Device Specific Settings
MNetwark Management
Media Interface
Signaling Interface
Signaling Forking

Session Border Controller for Enterprise

AVAYA

Media Interface: Micro SBC

Micro SBC

Media Interface

Log Out

g rmedia interface will require an application restart before taking effect. Application restarts can beis

MName Media P

10.6415.199

Port Rangs

35000 - 40000 Edit  Delete

Media_to_Avaya

Media_to_Vz 1.1.1.2 35000 - 40000 Edit Delete
Media_RWY _Internal 10.64.18.201 35000 - 40000 Edit Delete
Media_RWY_Extermal 1.1.1.3 35000 - 40000 Edit Delete
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6.11. Signaling Interface

The Signaling Interface screen is where the SIP signaling ports are defined. Avaya SBCE will
listen for SIP requests on the defined ports. Create a signaling interface for the inside and outside
IP interfaces.

To create a new Signaling Interface, navigate to Device Specific Settings = Signaling
Interface and click Add. The following screen shows the signaling interfaces defined for the
sample configuration.

Alarms  Incidents  Statisics  Logs  Diagnostics  Users l Help  Log Qut
Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: Micro SBC

Administration
Backup/Restare

Signaling Interface

Systermn Management

> Global Parameters Micro SBC Add
> Glahal Profiles Signaling IP TCPPot UDPPort TLS Pan TLE Profile
> SIF Cluster Sig_to_Avaya 10.54.19.199 5060 Mone Edit Delste
> Darnain Palicies
Sig_to_vz 1.1.1.2 5060 MNone Edit  Delete

> TLS Management
4+ Device Specific Settings Sig_Inside_RW 10.64.19.201 5060 MNone Edit Delete

Network Management Sig_Cutside_RW 1.1.13 5060 - 5061 AvayaSBCServer Edit Delete

Media Interface

Signaling Interface

6.12. End Point Flows - Server Flow

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URISs, etc.)
is used to determine which flow it matches. Once the flow is determined, the flow points to a
policy which contains several rules concerning processing, privileges, authentication, routing,
etc. Once routing is applied and the destination endpoint is determined, the policies for this
destination endpoint are applied. The context is maintained, so as to be applied to future packets
in the same flow. The following screen illustrates the flow through the SBC to secure a SIP
Trunk call.

“Call Server to “Call Server” Applied “Trunk Server to “Trunk Server”
SBC” Flow Palicy Group Rouling SBC” Flow Policy Group

IP-PBX

\ ) Call Server “Call Server to Applied “Trunk Server* “Trunk Server to

Policy Group SBC” Flow Routing Policy Group SBC” Flow

SIP Trunk Service Provider
V -

Avaya SBCE
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Create a Server Flow for IP Office and Verizon Business IP Trunk service. To create a Server
Flow, navigate to Device Specific Settings = End Point Flows. Select the Server Flows tab
and click Add as highlighted below.

Alarms  Incidents  Statistics Logs  Diagnostics Users Settings  Help  Log Qut
Session Border Controller for Enterprise AVAYA
4 Device Specific Settings = End Point Flows: Micro SBEC

Metwark

Management

Media Interface Subscriber Flows | | Server Flows

Micro SBC A
Signaling Interface Add

Signaling Farking
End Point Flows

over over a row to see its description

The following screen show the flow named “Verizon IPCC Flow” viewed from the sample
configuration. This flow uses the interfaces, polices, and profiles defined in previous sections.

View Flow: Vz IPCC Flow X

- Criteria - Profile
Flowe Name Wz IPCC Flow Signaling Interface Sig_to Wz
server Configuration  Verizon-IPCC Media Interface Media_to %z
LRI Group * End Paint Palicy Group  Wz-IPCC-Policy
Transport * Routing Profile [P Office
Remote Subnet * Topology Hiding Profile %z IPCC_TH
Received Interface Sig_to_Awaya File Transfer Profile Mone
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The following screen shows the flow named “IP Office Flow” viewed from the sample
configuration. This flow uses the interfaces, polices, and profiles defined in previous sections

View Flow: IP Office Flow X

- Profile

- Criteria

Flow Marme

LRI Group
Transport
Remaote Subnet

Received Interface

Server Configuration

IP Office Flow

IP Office

*

*

Sig_to Wz

Signaling Interface
Media Interface

End Paint Palicy Group
Routing Profile
Topology Hiding Profile

File Transfer Profile

Sig_to_Awaya
Media to Awvaya
SIP-Trunk-Palicy
Wz IPCC

default

Maone

The following screen summarizes the Server Flows configured in the sample configuration.

Dashhoard

Administration

Backup/Restore

Systern Management

> Global Parameters

> Global Profiles

> SIP Cluster

> Domain Policies

> TLS Management

4 Device Specific Settings
MNetwark Management
hedia Interface
Signaling Interface
Signaling Forking
End Point Flows
Session Flows
Relay Services
SHMP
Syslog Management
Advanced Options

> Trouhleshnoting

Session Border Controller for Enterprise

End Point Flows: Micro SBC
Subscriber Flows | | Server Flows
Micro SBC
Add
Click here to add a row
r Server Config ion: IP Office
Update

Priority

Routing
Profile

|_ 1 IP Office Flow Sig_to_vz Sig_to_Avaya gﬁj;umk' Wz_IPCC  ‘“iew Clone Edit  Delete
IPO
E IPO_RW_Flow Sig_Cutside_RW  Sig_Inside_RW Remaote default “Wigw Clone  Edit  Delete
Warker

r Server Configuration: VerizondPCC

Priority

Floy

1 Wz IPCC Flow

Sig_to_Avaya  Sig_to_Vz

Yz-IPCC-Palicy

IP Office  “iew Clone  Edit  Delete

DDT; Reviewed:
SPOC 3/7/2014

Solution & Interoperability Test Lab Application Notes
©2014 Avaya Inc. All Rights Reserved.

59 of 70
VZBIPCC-IPO9SBC




7. Verizon Business Configuration

Information regarding Verizon Business IP Trunk service offer can be found by contacting a

Verizon Business sales representative, or by visiting

http://www.verizonbusiness.com/us/products/voip/trunking/.

The reference configuration described in these Application Notes was located in the Avaya
Solutions and Interoperability Lab. The Verizon Business IP trunk service was accessed via a
Verizon Private IP (PIP) T1 connection. Verizon Business provided the necessary service

provisioning.

The following Fully Qualified Domain Names (FQDNSs) were provided by Verizon for the

reference configuration.

CPE (Avaya)

Verizon Network

adevc.avaya.globalipcom.com pcelban0001.avayalincroft.globalipcom.com

For service provisioning, Verizon will require the customer IP address used to reach the Avaya
SBCE. Verizon provided the following information for the compliance testing: the IP address
and port used by the Verizon SIP SBC, DNS server information, and the Direct Inward Dialed
(DID) numbers shown in Figure 1 and Table 1. This information was used to complete the

Avaya IP Office and Avaya SBCE configuration.
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8. Verifications

This section provides example verifications of the Avaya configuration with Verizon Business
Private IP (PIP) Trunk service.

8.1. Avaya SBCE
This section provides verification steps that may be performed with the Avaya SBCE.

8.1.1. Incidents

The Incident Viewer can be accessed from the Avaya SBCE Dashboard as highlighted in the
screen shot below.

Alarms  Incidents stics  Logs  Diagnostics  Users Settings  Help  Log Cut
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard

Administratian

Installed Devices

Inforrnation

Backup/Restare
P System Time 04:11:00 P MET Refresh EMS

Use the Incident Viewer to verify Server Heartbeat and to troubleshoot routing failures.

Incident Viewer AVAYA

Device | All | Category | All b’ [Refresh] [Generate Report]
Displaying results 1 to 15 out of 2001

Date Tirme Ca ry Device

Message Dropped 5937 44156573653 121913 226 PM Policy Micro SBC Mo Subscriber Flow Matched

Message Dropped 5937 44126065816 121913 224 PM Policy Micro SBC Mo Subscriber Flow Matched
Message Dropped 593744096853104 121913 223PM Policy Micro SBC Mo Subscriber Flow Matched

Message Dropped £93744081903710 121913 222PM Policy Micro SBC Mo Subscriber Flow Matched
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8.1.2. Tracing

To take a call trace, navigate to Device Specific Settings = Trace and select the Packet
Capture tab. Populate the fields for the capture parameters and click Start Capture as shown

below.

> SIF Cluster

> Domain Policies

> TLS Management

4 Device Specific Settings

Metwiark
Management

Media Interface
Signaling Interface
Signaling Forking
End Point Flows
Session Flows
Relay Services
SMNMP
Syslog Management
Advanced Options
4 Troubleshooting
Debugging
Trace

Dos
Learning

Session Border Controller for Enterprise

Trace: Micro SBC

Devices Call Trace | | Packet Capture H Captures ‘

Micro SBC
Status

Interface

Local Address
IP[Par]

Remote Address
*, *:Port, IF, IF:FPort

Protocol

Capture Filename

AVAYA

Maximum Number of Packets to Capture

Using the name of an existing capture will ovenurite it

Packet Capture Configuration

Ready

Al

1064.19.199

Al
1000

ipcc-test. poap

Start Capture Clear

When tracing has reached the desired number of packets the trace will stop automatically, or

alternatively, hit the Stop Capture button at the bottom.

Global Parameters
Glabal Profiles
SIP Cluster

Diomain Policies

TLS Management
4 Device Specific Settings

Netwark
Management

Media Interface
Signaling Interface
Signaling Forking
End Paint Flows
Session Flows
Relay Services
SHMP
Syslog Management
Advanced Options
< Trouhleshooting
Debugging
Trace

Session Border Controller for Enterprise

Trace: Micro SBC

Devices Call Trace || Packet Capture | | Captures |

Micro SBC

Status

Interface

Local Address
IF[Por]

Remote Address
= %:Port, IF, IF:Port

Pratocal

Capture Filename

AVAYA

A packet capture is currently in progress. This

Maxirnur Mumber of Packets to Capture

Using the name of an existing capture will ovenurite it

acket Capture Configuration

In Progress

Al T
106419159 *
Al v
1000

ipcc-test poap

Stop Capture

ill autormati b until the capture completes
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Select the Captures tab to view the files created during the packet capture.

Session Border Controller for Enterprise AVAYA

Signaling Interface Trace: Micro SBC
Signaling Farking
End Paint Flows

Session Flows Call Trace ‘ ‘ Packet Capture ‘ ‘ Captures |
Micro SBC
Relay Services Last Modified ¥ | Descending ¥ | Sont | | Resst Refresh
ShMP
Syslog Management D .
t2st_20131220145230. 4096 ecember 20, 213 25T PM - ey
Advanced Options prertesi peap MST Fee
# Troubleshonting DSCPverification_ 2013121914261 peap 95 520 Pecember 19, 03 22841 PM  pjorg
Debugging
Trace test-irace 20130204084532 prap 4096 February 4, 2013 B.47.00 AM Delele
Dos
Learning

The packet capture file can be downloaded and then viewed using a Network Protocol Analyzer
like WireShark.

ipcc-test_20131220145330. pcap - Wireshark

File Edit ‘Wiew Go Capture Analyze Statistics Telephony Tools  Help
B EEdREE QAe»aTL|EE QB SR X O
Filter: ‘s\p |v Expression... Clear Apply
Mo, Tirne Source Destination Protocol Info
13 B.752790 10.64.15.199 10.80.150.70 SIP Request: OPTIONS sip:10.80.150.70
16 8.759564 10.80.150.70 10.64.19.1599 SIP/SDP Status: 200 oK, with session description
20 16.614514 10.64.15.199 10.80.150.70 SIPSSDP Reguest: INVITE sip:B568502380810.80.150.70:5070, with session description
>
Frame 20: 1047 bytes on wire (8376 bits), 1047 bytes captured (8376 hits)
@ Ethernet II, Src: Portwell_34:5b:c6 (00:90:Ffb:34:5b:c6), Dst: Avaya_a3:a2:lc (80:Tb:5h:a3:a2:1c)
Internet Protocol, src: 10.64.19.199 (10.64.19.199), pst: 10.80.150.70 (10.80.150.70)
® Transmission Control Protocol, Src Port: 14257 (14257), Dst Port: vtsas (5070), Seqg: 2, ack: 1, Len: 993
= Session Initiation Protocol
] ;.
= Message Header
From: <sip:+130353811680810.64.19.109:14257; user=phone>; tag=ah1547da
@ To: sip:18668502380810.80.150. 70:5070
B CSeq: 1 INVITE
Call-ID: wlss-da7h66eb-ddc4d300185eadc713c41c5010ce%8c17db83163b45dFe3270-0104-6400
CONTact: <sipi+13035381180610,64.19.199:5060; sipappsessionid=app-1kahlgovwwshy; transport=tcps
Record-route: <sip:l0.64.19.1959:5060; ipcs-11ne=22626; 1r;transport=tcp>
Allow: INVITE, ACK, BYE, OPTIONS, CAMCEL, SUBSCRIBE, REFER
Supported: timer
User-Agent: CS2000_NGSS/9.0
Max-Forwards: 63
via: SIR/2.0/TCP 10.64.1%.199:5060;branch=z8hGdbK-51632-000951240662-1--51632—
P-asserted-Identity: “"THORNTON ,C0" <s5ipi413035381180610.64.19.199:14257; user=phaone>
Min-sSE: 2000
content-Type: application/sdp
content-Length: 206
= Message Body
= Session Description Protocol
session Description Protocol version €v): ©
® ownerCreator, Session Id (o): PVG 300836872 300386872 IN IP4 10.64.15.190
Session Mame (s): -
connection Information (<) IW IP4 10.64.19.199
@ Time Description, actiwe time (t): 0 0
media pescription, name and address (m): audio 35378 RTP/2WP 18 0 8 101
@ Media attribute (a): rtpmap:101 telephone-event /8000
media attribute ¢ad: fmtp:lol o0-15
@ Media attribute (a): ptime:20
® Media attribute (ad; fmtn:l8 annexb=no v
O SIP Request-Line (sip. Request-Ling), 47 bytes Packets: 22 Displayed: 3 Marked: 0 Load time: 0:00.000 Profile: Default
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8.2. IP Office
This section provides verification steps that may be performed with the IP Office.

8.2.1. System Status

The System Status application is used to monitor and troubleshoot IP Office. Use the System
Status application to verify the state of the SIP trunk. System Status can be accessed from Start
-> Programs - IP Office - System Status. Or by opening an Internet browser and type the
URL.: http://ipaddress where ipaddress is the IP address of the Avaya IP Office LANL1 interface.
Click on System Status to launch the application.

<« C 1 10.80.150.70/indesx himl

AVAYA

IP Office R9.0

System Mame: SIL Lab
IP Address: 10.80.150.70

jce Web
Fhomede Base
Avaya Support

© 2000 - 2013 Avaya Inc. Allrights reserved.

The following screen shows an example Logon screen. Enter the IP Office IP address in the
Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

AVAYA IP Office System Status

Help  About

Online | Offline

Logon

Control Unit TP Address: LRIk RS ]

Services Base TCP Port: BikIsE)

Local IP Address: RN EN

UL B Adninistrator

Password: L 11111111 1111]

Auto reconnect

IP Office System Status Yersion 2,0,0,0 bui
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

Summary Alarms

SIP Trunk Summary

Peer Dormain Mame: 10.64,19,199

Resolved Address: 10.64.19.199

Line Murnber: 15

Mumber of Administered Channels: 40

Murnber of Channels in Use: a

Administered Compression: G722, G729 A, G711 Mu
Silence Suppression: Cff

Layer 4 Protocal: TCP

SIP Trunk Channel Licenses: 5 . oy
SIP Trunk Channel Licenses in Use: ]

SIP Device Features: REFER. {Incoming and Outgoing)

1 Ide |00:14:08 rS
2 Idle  |1day ... E|
3 Idle  |1day ... =
4 Idle  |1day ...
5 Idle  |1day ...
[ Ide |1dav...
7 Idle  |1day ...
g Ide |1day..
9 Idle  |1day ... W
Trace Al ] [ Pause ] [ Fing ] Call Details Print... ] [ Save As...

sh after config change done. 2:43:15 PM COnline

Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

napshot  LogOff  About

Alarms for Line: 18 SIP 10.64.19.199

Al 5 (3)
Configuration (0)
Service (0)

B i Trunks (3)
Line: 5 (0)
Line: 6 {0}
Line: T {0}
Line: 8 {(0)

Alarms

QCourrences Error Description

Link {0)
Call Quality of Se
TLS (0)

Clear all Save As..,

Print. ..

Online
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8.2.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be
accessed from Start - Programs > IP Office - Monitor. The application allows the
monitored information to be customized. To customize, select the button that is third from the
right in the screen below, or select Filters > Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked. SIP messages will appear in the trace with
the color red for Rx and blue for Tx. To customize the color, right-click on SIP Rx or SIP Tx
and select the desired color.

P

T1 | wComp | wew | wmen | son | ssl | Jade bl
aTM | cal | DTE | ECont | FrameRelay | GOD | H323 | Interface

150N 1 Key#Lamp] Directary 1 Media ] FPP 1 R2 ] Flouting] Services  SIP ]System

Events

™ Sip [~ STUN [ SIP Dect
Packets
[ SIP Reg/Opt A [ 5IP Misc Rx
[~ SIP Reg/Opt T [ SIP Misc Tx
[~ SIPCallRx [ Cm Motify R
[~ SIPCall T [ Crn Matify T
¥ Sip Rz [~ hex IF Filter [nnn. nnn. nnn. nnn)

v Sip Tx [~ hex

Default All | Clear All | Tab Clear Al | Tab Set Al | i[: | Cancel |

Sl | Load File | LoadF‘artiaIFiIe| Select Fie |
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As an example, the following shows a portion of the monitoring window for an inbound call to
Verizon IP Toll Free number 1-866-850-2380. Details of the SIP INVITE message sent by
Verizon are shown below. This information matches the configuration in these Application
Notes and is not intended to be prescriptive. The intent is to illustrate the INVITE sent by
Verizon in the sample configuration, along with the means to retrieve this type of trace
information from IP Office.

@

EJ: Avaya IP Office SysMonitor, - [STOPPED] Monitoring 10.80.150.70 ; Log Settings - C:\Documents and Settings\...\sysmonitorsettings.ini
File Edit View Filkers Status Help

=a| ~l8|7| x> @

TovoToT TICIOCES TiE  DAWST ias oy DrasT T ELToe o TCTIE T Loy i SR T Ty IIn OO DEREIT T SRR

7 7 = EITTTTERTT IITTI T T RSSO TIITIeT
L&:ze: 0L 11139%9m% SIP Bx: TCP 10.64.19.199:14665 -> 10.80.150.70: 5060 %
INVITE sip:8668502380010.80.150.70 3IF/2.0

From: <sip:+l30535351180[10.64.19,199;: 14665 ;user=phone> ; tag=55£74d9

To: sip:l86655023500810.80.150.70

CSeq: 1 INVITE

Call-ID: wlss-eif%belfc-dbi9cEll8l8beado?l3cdledf21579d%9a2bhdbdaaahacled08E£50-0106-4932

Contact: <s5ip:+l13035351180E10.64,19.199: 5060;sipappsessionid=app-1x0s2gdilTugi; transport=tops

Record-Foute: <sip:l0.64.19,199:5060;ipcs-1ine=30229; 1 ; transport=top>

Allow: INVITE, ACE, BEYE, OFTIONS, CANCEL, SUEBSCRIEE, FEFER

User-Agent: C32000_NGI5 9.0

Max-Forwards: 65

Wia: SIP/Z.0/TCP 10.64.19.199:5060;branch==z0hG4bE-s1632-001956417079-1--21632-

P-Aszzerted-Tdentity: "THORNTON LC0" <Eip:r+13035381180E10.64.19.199: 14665 ;user=phone>

Remote-Address: 172.30.205.164:11239:1:1

Content-Type: applicationssdp

Content-Length: Z05

w=0

o=PWG 2722735022 ZT722735922 IN IP4 10.54.19.199
g=—

c=IN IF4 10.54.19.199

©=0 0

m=audio 35250 RTP/ALWF 13 0 § 101

a=rtpmap: 101 telephone-event/S000

a=fmtp: 101 O-15

a=ptime: 20

a=fumtp: 16 amnexb=no
L5:26:01 111403m3 CMCallEwt: 0.1003.0 -1 BaseEF: NEW CMEndpoint f£4cd0aSc TOTAL NOW=1 CALL_LIST=0
L5:26: 0L 111406m3 SIF Tx: TCP 10.80.150.70:5060 -> 10.64,19.199:14665

SIP/2.0 100 Trying

Wia: SIP/Z.0/TCP 10.64.19.199:5060;branch=z0hG4bE-s1632-001956417079-1--21632-

Record-Route: <sip:l0.64.19,199:5060;ipos-1ine=30229;1r ;transport=tcp>

From: <35ip:+13035351180Q@10.64.19,199: 14665 ;user=phones>;tag=58£74d494

Call-ID: wlss-e2%befc-di9colliliseadc?licdledE21579d%a2hdbdaaabaclod0GEi0-0106-4932

Cieq: 1 INVITE

Allow: INVITE,ACE,CANCEL,QFTIONS,EYE, INFO,NOTIFY

Supported: timer

Gartars TH MNfFire O N 1 0 koild 245 bt
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9. Conclusion

IP Office is a highly modular IP telephone system designed to meet the needs of home offices,
standalone businesses, and networked branch and head offices for small and medium enterprises.
These Application Notes demonstrated how IP Office Release 9.0 with Avaya Session Border
Controller for Enterprise Release 6.2 can be successfully combined with a VVerizon Business IP
Trunk SIP Trunk Service connection to create an end-to-end SIP Telephony business solution.
By following the example configurations provided in this document, customers using Avaya IP
Office and Avaya SBCE can connect to the PSTN via a Verizon Business IP Trunk SIP Trunk
service connection, thus eliminating the costs of analog or digital trunk connections previously
required to access the PSTN. Utilizing this solution, IP Office customers can leverage the
operational efficiencies and cost savings associated with SIP trunking while gaining the
advanced technical features provided through the marriage of best of breed technologies from
Avaya and Verizon.

IP Office Release 9.0 with Avaya Session Border Controller for Enterprise Release 6.2 has
not been independently certified by Verizon labs. These Application Notes can be used to
facilitate customer engagements via the Verizon field trial process, pending Verizon labs
independent certification.

10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com

[1] 1P Office 9.0 Installing IP500/1P 500 V2, Document Number 15-601042, November 2013
[2] IP Office Manager, Document Number 15-601011, November 2013

[3] IP Office Application server 9.0 Installation and Maintenance, August 2013

[4] 1P Office 9.0 Using System Status, Document Number 15-601758, August 2013

[5] Administering Avaya Flare® Experience for iPad Devices and Windows, September 2013
[6] Configuring the Avaya Session Border Controller for IP office Remote Workers, Sept 2013
[7] Installing Avaya Session Border Controller for Enterprise, June 2013

[8] Administering Avaya Session Border Controller for Enterprise, January 2014

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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The Application Notes referenced below correspond to the formal compliance testing by Avaya
and Verizon Business for IP Office Release 8.1 with Avaya Session Border Controller for
Enterprise Release 6.2 with Verizon IPCC Service Suite.

[VZBIPCCIPO81SBC] Application Notes for Configuring SIP Trunking using Verizon Business
IP Contact Center VoIP Inbound and Avaya IP Office Release 8 with Avaya Session Border
Controller for Enterprise, Issue 1.0

The Application Notes referenced below correspond to the formal compliance testing by Avaya
and Verizon Business for IP Office Release 9.0 and Avaya Session Border Controller for
Enterprise with Verizon IP Trunk Service Suite.

[VZBIPT-IPO9SBC] Application Notes for SIP Trunking Using Verizon Business IP Trunk SIP
Trunk Service and Avaya IP Office Release 9.0 with Avaya Session Border Controller for
Enterprise Release 6.2 , Issue 1.0

[RFC-3261] RFC 3261 SIP: Session Initiation Protocol http://www.ietf.org/rfc/rfc3261.txt

[RFC-2833] RFC 2833 RTP Payload for DTMF Digits, Telephony Tones and Telephony Signals
http://www.ietf.org/rfc/rfc2833.txt

Information in the following Verizon documents was also used for these Application Notes.
Contact a Verizon Business Account Representative for additional information.

e [VZ-Test-Plan] Test Suite for CPE IP Trunking Interoperability v1.3
e [VZ-Spec] Verizon Business IPCC Trunk Interface Network Interface Specification,
Document Version 2.2.1.9
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©2014 Avaya Inc. All Rights Reserved.

Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ gare registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.

DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 70 of 70
SPOC 3/7/2014 ©2014 Avaya Inc. All Rights Reserved. VZBIPCC-IPO9SBC


mailto:devconnect@avaya.com

